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Disclaimer
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Contact Us
Motorola Solutions Support Center
The Solutions Support Center (SSC) is the primary Motorola Solutions support contact. Call:

• Before any software reload.

• To confirm troubleshooting results and analysis before removing and replacing a Field Replaceable
Unit (FRU) and Field Replaceable Entity (FRE) to repair the system.

For... Phone

United States Calls 800-221-7144

International Calls 302-444-9800

North America Parts Organization
For assistance in ordering replacement parts or identifying a part number, contact the Motorola
Solutions Parts organization. Your first response when troubleshooting your system is to call the
Motorola SSC.

For... Phone

Phone Orders 800-422-4210 (US and Canada Orders)

For help identifying an item or part number, select
choice 3 from the menu.

302-444-9842 (International Orders)

Includes help for identifying an item or part number and
for translation as needed.

Fax Orders 800-622-6210 (US and Canada Orders)

Comments
Send questions and comments regarding user documentation to 
documentation@motorolasolutions.com.

Provide the following information when reporting a documentation error:

• The document title and part number

• The page number with the error

• A description of the error

We welcome your feedback on this and other Motorola Solutions manuals. To take a short, confidential
survey on Motorola Solutions Customer Documentation, go to docsurvey.motorolasolutions.com or
scan the following QR code with your mobile device to access the survey.
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About ASTRO 25 Express Setup
Guide
This guide provides basic installation, configuration, and verification information to support the initial
setup of the essential equipment in the ASTRO® 25 Express trunking system.

What is Covered in This Manual?
This document contains the following chapters:

• ASTRO 25 Express System Preparation on page 21 describes basic preparation steps for an
ASTRO® 25 Express system.

• Equipment Setup on page 23 describes the equipment setup used.

• Test and Verification on page 51 provides a list of recommended test equipment along with
activities necessary to support performance testing and verification for the GTR 8000 Base Radio
and Radio Frequency Distribution System (RFDS) activities.

• Site Preparation and R56 Compliance Checklist on page 75 provides information about obtaining
and preparing all hardware, software, support, and test equipment necessary to set up, configure,
and optimize the system.

• Service Laptop and Software Setup for ASTRO 25 Express on page 109 describes service laptp
requirements and related software required.

Helpful Background Information
Motorola Solutions offers various courses designed to assist in learning about the system. For
information, go to http://www.motorolasolutions.com/training to view the current course offerings and
technology paths.

Related Information
See the following documents for associated information about the radio system.

Related Information Purpose

Standards and Guidelines
for Communication Sites

Provides standards and guidelines that should be followed when set-
ting up a Motorola communications site. Also known as R56 manual.
This document may be purchased by calling the North America Parts
Organization at 800-422-4210 (or the international number:
302-444-9842).

System Documentation
Overview

Provides an overview of the ASTRO® 25 new system features, docu-
mentation set, technical illustrations, and system-level disaster recov-
ery that support the ASTRO® 25 radio communication system.
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Chapter 1

ASTRO 25 Express System
Preparation
This chapter describes basic preparation steps for an ASTRO® 25 Express system.

1.1
Preparation Overview

IMPORTANT: Before setting up the site, fully understand and follow all safety, training, and
certification requirements and considerations.

Motorola Solutions offers various courses designed to assist in learning about the system. For
information, go to http://www.motorolasolutions.com/training to view the current course offerings and
technology paths. Motorola Online (MOL) website contains additional information, for more details go
to https://businessonline.motorolasolutions.com and then click Resource Center.
Understand and follow R56 standards and guidelines for communication sites, including all safety
requirements and considerations. See the R56 Standards and Guidelines for Communication Sites
manual.

Table 1: R56 Compliance Audit

Activity Description Reference

R56 Stand-
ards and
Compliance

The site should meet R56 stand-
ards and audited by an ETA-certi-
fied R56 auditor to verify compli-
ance.

• Standards and Guidelines for
Communication Sites manual may
be purchased by calling the North
America Parts Organization at
800-422-4210 (or the international
number: 302-444-9842).

• Site Preparation and R56 Compli-
ance Checklist on page 75: R56
Compliance Checklist and Audit
Form is included in this appendix.

This table lists the references to the information required for site preparation.

Table 2: Prepare Support and Test Equipment

Activity Description Reference

Service Lap-
top Setup

A service laptop can be used to in-
stall and configure components and
to check component status.

See Service Laptop and Software
Setup for ASTRO 25 Express on
page 109 for details regarding the
hardware and software require-
ments, recommendations, and con-
siderations for a service laptop.

Table continued…
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Activity Description Reference

Equipment
Setup

Covers the equipment setup proce-
dures which are performed at the
site.

See Equipment Setup on page 23.

Test and Veri-
fication

Covers the equipment test and veri-
fication procedures which are per-
formed at the site.

See Test and Verification on page
51.

Configuration Covers the basic configuration pro-
cedures which are performed at the
site.

See GTR 8000 Base Radio Configu-
ration Setup on page 36 and GCP
8000 Site Controller Configuration
Setup on page 42.
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Chapter 2

Equipment Setup
Equipment setup in this guide is based on a three-cabinet GTR 8000 Expandable Site Subsystem
configuration (one primary cabinet and two expansion cabinets) for an ASTRO® 25 Express system.

2.1
ASTRO 25 Express Equipment Checklist
Take an inventory of all equipment with a Motorola Solutions representative present to ensure that the
order is complete. Carefully inspect all equipment and accessories to verify that they are in good
condition. Promptly report any damaged or missing items to the Motorola Solutions representative.

CAUTION: Do not tamper with factory configuration settings for these devices. Factory
configuration settings include software configuration, firmware release, password, and physical
connections. Motorola Solutions has configured and connected these devices to meet specific
performance requirements. Tampering with these devices may result in unpredictable system
performance or a catastrophic failure.

Table 3: Equipment Checklist

Equipment Checklist

GTR 8000 Expandable Site Subsystem (Primary Cabinet Expansion
Cabinets)

Junction Panels

Site Receive Multicouplers (RMCs)*

Transmit (TX) Filter

GCP 8000 Site Controller

Expansion Hubs (XHubs)

Combiner*

Power Amplifiers (up to six, one for each base Radio)

Cabinet RMCs*

RMC

RMC Pass Through Module (UHF R1 and VHF only)

Transceiver (XCVR) – up to six per cabinet

Power Supplies (up to six, one for each base radio)

*Not available for UHF R1 and VHF
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Figure 1: Site Equipment Basic Components for 700/800 MHz System

2.1.1
Receive Expansion Cable Length Specifications
This table provides the specifications for the GTR 8000 receive expansion cable lengths. The receive
expansion cables connect the Expansion Cabinets and are not provided. Cable length is not critical;
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however, maintain the lengths within ±50% of the values listed in the table to achieve a good balance
between all receivers. Keep within a nominal loss of 1 dB.

Table 4: GTR 8000 Receive Expansion Cable Length Specifications

Cable Type Length (ft) Length (m)

EnviroFlex™ EF142 6.6 2

1/4–inch Superflex or
equivalent

19 5.8

3/8–inch Superflex or
equivalent

28 8.5

1/2–inch Superflex or
equivalent

31 9.5

2.2
GTR 8000 Expandable Site Subsystem Setup
This section describes brief setup and configuration procedures relating to the GTR 8000 Expandable
Site Subsystem. The following table lists the activities for installing the site equipment. In case detailed
procedures are need, the table also covers the chapter references in the GTR 8000 Expandable Site
Subsystem Feature Guide.

Setup Prerequisites:

• Appropriate cables

• Access to Software Download and Configuration/Service Software (CSS)

• IP/Domain Name Service (DNS) information

• Login and password information

Table 5: Installation Overview

Activity Description Manual Reference

Unpack and in-
spect

Inspect and take inventory of all
racks or cabinets, cables, and other
equipment to ensure that the order
is complete.

Chapter 3, “Equipment Inspec-
tion and Inventory Recommen-
dations”

Install hardware Install all equipment using the site
drawings and other documents pro-
vided by the Motorola Solutions
representative. Follow the installa-
tion standards and guidelines for
placing and installing the equip-
ment.

Chapter 3, “Placement and
Spacing Recommendations”,
“Cabinet Bracing Recommenda-
tions”, “Floor Mounting Proce-
dure for Cabinets or Racks”,
“Floor Mounting for the GTR
8000 Expandable Site Subsys-
tem”

Ground cabi-
nets/racks

Ground cabinets/racks and equip-
ment to protect against ground
faults, electrical surges, and light-
ning in accordance with R56 stand-
ards.

Chapter 3, “Bonding and
Grounding Requirements”, “Elec-
trostatic Discharge Recommen-
dations”

Table continued…
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Activity Description Manual Reference

Connect cables Connect all cables between cabi-
nets/racks and external devices.

Chapter 3, “Cabling Require-
ments”

Connect multi-
ple cabinets/
racks and an-
tennas

Follow the junction panel connec-
tion diagrams for Primary and Ex-
pansion cabinets and antennas.

GTR 8000 Expandable Site Sub-
system Junction Panel Quick
Connections on page 30

Preliminary
check

Run a preliminary check of all
equipment before applying power
and beginning software installation.

Chapter 3, “Power Guidelines
and Requirements” and “Con-
necting Power”

2.2.1
GTR 8000 Expandable Site Subsystem Power, Grounding, and
Interface Connections
This section describes the GTR 8000 Expandable Site Subsystem power, grounding, and interface
connections.

2.2.1.1
GTR 8000 Expandable Site Subsystem Power Connections
This section covers connecting power cables to the GTR 8000 Expandable Site Subsystem and the
power distribution module, calculating the length of the wire for various gauges, and mounting the
battery temperature sensor.

Power cables are connected to the GTR 8000 Base Radio Power Distribution Module. When making
these connections, consider the following:

• The power distribution module located with the junction panel provides connections for AC and DC
input.

• One or two DC inputs can be connected to the DC section of the power distribution module.

• Each GTR 8000 Base Radio must have a single, separate AC source with the proper power rating
connected to the appropriate terminals in the AC section where it is then fed to the corresponding
AC power supply input.

• Each DC input termination is rated for a maximum of 108 A.

2.2.1.2
GTR 8000 Expandable Site Subsystem Grounding Connections
Components in the GTR 8000 Expandable Site Subsystem are grounded to the rack grounding bar. To
properly ground the GTR 8000 Expandable Site Subsystem, connect the rack grounding bar to the
master ground bus bar through the junction panel.

2.2.1.3
Laptop Interface Connections
The service laptop must accommodate one of the following two interface connections:

• Connecting Through a Serial Port Link on page 27

• Connecting Through an Ethernet Port Link on page 28
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2.2.1.3.1
Connecting Through a Serial Port Link
Perform this procedure to make a serial connection. The primary task of the serial connection is to set
the device IP address and to set serial security services.

Prerequisites: The Configuration/Service Software (CSS) is loaded on your computer. See the Private
Network Management Client Feature Guide if necessary.

Procedure:
1 Connect a serial cable to a laptop or computer running the CSS application, and the serial

connector on the devices module. The serial cable, an RS232 cable, is a DB-9 straight through
serial cable (female DB-9 to male DB-9). If the laptop does not have a serial port, use a USB-to-
serial converter external device.

2 Open the CSS application.

3 Select Tools → Connection Configuration from the menu.

4 From the Connection Screen dialog box, select Serial on the Connection Type field.

5 From the Serial Settings on the dialog box, select the communication port in the Serial Port
field that matches the one selected on the computer.

6 In the Baud Rate field, select the baud rate with which you want to communicate with the
device: Baud Rate 19200

7 Click Connect.
8 In the login/password prompt screen, provide the required credentials as follows. Click OK.

When accessing the device, if the default passwords do not work, the passwords may have
been set to default values by a different system release of software. See the CSS Online
HelpResetting Device Passwords screen to reset the passwords to the current software
release defaults. If Authentication Services are not enabled on a device, type any
alphanumeric characters to populate the Username, Password, and Elevated Privileges
password fields, as they cannot be left blank.

Figure 2: CSS Login Banner

• If a domain controller is available on the network, type the Username and Password for your
RADIUS service user account assigned to the netwadm group in Active Directory. (The
default user is serviceuser).

• If a domain controller is not available on the network, type the Username and Password for
the local bts_service account.

• If the Elevated Privileges Password field is active, type the Elevated Privileges Password
that was set up for this device.
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See “Setting the Serial Security Services Using CSS” in the GTR 8000 Expandable Site
Subsystem Feature Guide to configure Authentication Services on the device.

9 Click OK to close the dialog box.

The blank CSS main window appears. The Service menu is not available until you read the
configuration file from the device using an Ethernet connection.

2.2.1.3.2
Connecting Through an Ethernet Port Link
Connect through a serial port link to set the IP address of the device and to set the serial security
services. All other device function and feature configurations are performed via an Ethernet port
connection in the Configuration/Service Software (CSS).

Prerequisites: CSS is loaded on your computer. See the Private Network Management Client Feature
Guide if necessary. This procedure describes the steps required to perform a serial connection.

Procedure:
1 Connect a serial cable to a laptop or computer running the CSS application, and the serial

connector on the device module. The serial cable, an RS232 cable, is a DB-9 straight through
serial cable (female DB-9 to male DB-9). If the laptop does not have a serial port, use a USB to
serial converter external device.

• For a base radio, the IP address of the laptop must be set to the 192.168.1.<x> subnet
(where <x> is any number between 2 and 253). Configure the Speed/Duplex setting of the
computer Ethernet interface to 10 Mb Half Duplex.

• For a site controller, the IP address of the laptop must be set to an address on the subnet of
the local site, which varies depending on the site and zone numbers.

2 Open the CSS application.

3 From the menu, select Tools → Connection Configuration.

4 From the Connection Screen dialog box, verify that Ethernet is selected in the Connection
Type area.

5 If connected through the LAN switch, specify the IP address for the device in the Ethernet
Settings area and perform the following actions:

If… Then…

If you know the IP ad-
dress for the device.

perform the following actions:

a Enter the IP address for the device in the Device IP Ad-
dress field.

b Continue with step 6.

If you have a Trunked
Device and do not
know the IP address,
but know the system
identification of the de-
vice (the zone, site,
subsite, and device ID
of the device).

perform the following actions:

a Click Fetch DNS Entry to open the DNS IP Address Calcu-
lation Screen dialog box.

b Select the desired device type from the Device list box.

c Enter the proper values in the Zone, Site, Subsite, and De-
vice ID fields.

NOTICE: Some fields, such as Subsite, do not al-
low entries for some devices. Therefore, select the
device first.
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If… Then…

d Click OK.

The Domain Name Services (DNS) information of the device
automatically appears in the Device IP Address field.

e Continue with step 6.

6 If connected directly to the Ethernet service port of the device, click Front Panel Ethernet.
7 Click Connect.

If this device is SNMPv3-capable, a Passphrase Prompt screen appears. Proceed to step 9.

Figure 3: SNMPv3 Security Level Option Prompt

For Windows XP computers: If after clicking Connect, a "comm.Error" is encountered when
connecting to the front panel Ethernet port on a base radio, follow the procedure in step 8 to
repair the local area connection (LAN) or high-speed Internet connection.

8 Clear the ARP cache and allow for a new Ethernet MAC ID to be associated with the base radio
fixed IP address.

The front panel Ethernet port on GTR 8000 Base Radios have a fixed IP address (192.168.1.1).
However the Ethernet MAC ID for each front panel connection is unique to each base radio. A
communication error can occur when configuring multiple base radios through the front panel
Ethernet port. When connected to the initial base radio, Windows XP associates the fixed IP
address of the front panel port with the front panel Ethernet MAC ID. When connecting to the
next base radio, the Address Resolution Protocol (ARP) cache is not cleared and causes a
communication error.

a In Windows XP, from the Start menu, select Settings → Network Connections → Local
Area Connection

b Click the Support tab and select Repair.
The Repair Local Area Connection window opens and displays the different caches that
are cleared.

c Reconnect the Ethernet cable to the front panel Ethernet port, if not connected.

9 In the SNMPv3 Security Level Option Prompt, enter the User Information and Passphrase
Information. Click OK. If Authentication Services are not enabled on a device, click OK when
the window appears.
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See “Changing SNMPv3 Configuration and User Credentials in CSS” in the GTR 8000
Expandable Site Subsystem Feature Guide to configure or change SNMPv3 configuration and
user credentials on the device.

10 Select File → Read Configuration From Device from the menu.

The parameters download from the device to the computer. When the download is complete, the
CSS main window opens. Use the map on the left side of the screen to view configuration
information for the device.

2.2.1.4
GTR 8000 Expandable Site Subsystem Junction Panel Quick Connections
The junction panel for the GTR 8000 Expandable Site Subsystem provides locations for all the
connections to external devices for the standard configuration. Cables provided by Motorola Solutions
include the specific connectors required for the junction panel on one end and the subsystem
equipment on the other end.

The figures provide information on the 700/800/900/UHF R2 435–524 MHz and UHF R1 380–435
MHz/VHF 136–174 MHz junction panel connections for the following GTR 8000 Expandable Site
Subsystem configurations:

• GTR 8000 Expandable Site Subsystem Prime Cabinet for ASTRO® 25 Express System

• GTR 8000 Expandable Site Subsystem Prime Cabinet with Expansion Cabinet for ASTRO® 25
Express System

• GTR 8000 Expandable Site Subsystem Expansion Cabinet for ASTRO® 25 Express System

IMPORTANT: Do not remove the label from a connector location until you insert the connector.

Figure 4: Junction Panel for Prime Cabinet (700/800/900/UHF R2 435–524 MHz)
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• A. RF coax to Receive antenna

• B. RF coax to Transmit antenna

Figure 5: Junction Panel for Prime Cabinet with Expansion Cabinets (700/800/900/UHF R2 435–
524 MHz)

• A. RF coax RX Expansion ports: Cab#1 is primary, Cab#2 and #3 are for Expansion cabinets

• B. RF coax to Receive antenna

• C. RF coax to Transmit antenna

• D. Ethernet RJ-45 connection for the site controller Expansion Hubs (XHubs) in Expansion cabinets
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Figure 6: Junction Panel for Expansion Cabinet (700/800/900/UHF R2 435–524 MHz)

• A. RF coax to the RX Expansion port in Primary the junction panel

• B. RF coax to Transmit antenna

• C. Ethernet RJ-45 connection for the site controller XHubs in the Expansion cabinets
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Figure 7: Junction Panel for Prime Cabinet (UHF R1 380–435 MHz/VHF 136–174 MHz)

• A. BNC female connector to Receive Multicoupler (one for each base radio) TX antenna connection
through third-party combiner

Figure 8: Junction Panel for Prime Cabinet with Expansion Cabinets (UHF R1 380–435 MHz/VHF
136–174 MHz)

• A. BNC female connector to Receive Multicoupler (one for each base radio)

• B. Ethernet RJ-45 connection for the site controller XHubs in Expansion cabinets. Individual TX
antenna connections through combiner to TX RFDS
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Figure 9: Junction Panel for Expansion Cabinet (UHF R1 380–435 MHz/VHF 136–174 MHz)

• A. BNC female connector to Receive Multicoupler (one for each base radio)

• B. Ethernet RJ-45 connection for the site controller XHubs in Expansion cabinets. Individual TX
antenna connections through combiner to TX RFDS

2.2.1.5
GCP 8000 Site Controller Interface Connections
The GCP 8000 Site Controller has ports on the front and the back that allow it to connect to various
devices, including base radios, expansion ports, and other site equipment. In a GTR 8000 Expandable
Site Subsystem configuration, the Ethernet connections from the individual base radios run on the
backplane and connect to the switch on the site controller. This configuration minimizes the need for
Ethernet cables.
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Figure 10: Ports on the GCP 8000 Site Controller for a GTR 8000 Expandable Site Subsystem

Table 6: Description of Ports on the GCP 8000 Site Controller (Front View)

Port Description

Service Port (DB-9) Service port for initial configuration of the site
controller IP address.

Service Port (RJ-45) Connects to service computer/laptop for local ac-
cess using Configuration/Service Software (CSS).
Also may be used for localized software down-
loads.

Router (Gateway port) Not in use.
Table continued…
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Port Description

Site Expansion (15) Connection to Cab #1-5 ports on the junction
panel to connect to the Expansion Hubs (XHubs)
in the expansion cabinets.

Frequency Calibration Port available on the site controller module for
measuring and calibrating the frequency refer-
ence.

2.3
Configuration Manager for Trunking
The Configuration Manager software is an ASTRO® 25 software application that supports installation,
configuration, and verification of your system. The Configuration Manager provides the capability for a
system manager to configure radio users and talkgroups in a Subscriber Access Control Database in
the system site controller. In an ASTRO® 25 Express system, the integrated GCP 8000 Site Controller
functions as the system site controller. Configuration Manager can be deployed on a service laptop or
on a customer provided workstation. See the Configuration Manager for Trunking Systems User Guide.

2.4
GTR 8000 Base Radio Configuration Setup
Use the Configuration setup to verify or establish configuration parameters for the system components.

Locate the IP address for the equipment before performing the procedures. See the IP plan that came
with the system.

2.4.1
GTR 8000 Base Radio Configuration Using CSS

Table 7: Base Radio Configuration

Activity Description Reference

Configure
the Base
Radios

If not open, launch the Configuration/Service
Software (CSS) and open the CSS Core
Help. In the Contents, expand the ASTRO 25
Express System option and select the Proc-
ess topic.

CSS Online Help, “Process to
Configure ASTRO 25 Express
System”. Configuration Screens
on page 38 lists all Base Radio
configuration screens and the
fields to configure.

Table continued…
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Activity Description Reference

Figure 11: Base Radio Configuration

2.4.1.1
Configuring a GTR 8000 Base Radio Using CSS
Follow this process to configure the GTR 8000 Expandable Site Subsystem for an ASTRO® 25
Express System using the Configuration/Service Software (CSS).

CAUTION: Changing the GTR 8000 Base Radio parameters can seriously affect performance.
See your custom configuration templates for configuration recommendations provided from
your Motorola Solutions representatives when configuring the devices. Do not deviate from
specified settings without following the proper change procedures for your organization.

Prerequisites: Obtain the IP address for the transceiver before performing this procedure. Contact
your system administrator for this information.

Process:
1 Connect through the Ethernet port to the site controller and then read the configuration file from

the transceiver. See Laptop Interface Connections on page 26 for instructions.

2 Click System in the System tree and complete the fields.

3 Click Site in the System tree and complete the fields.

4 Click Channel in the System tree and complete the fields.

5 Click Configuration in the System tree and complete the fields on all four tabs.

6 From the menu:

• To save the configuration data to a new archive, select Save As → File
• To overwrite the existing archive file, select Save → File

IMPORTANT: Save any configuration changes to a local or network drive as described in
step 7. If the transceiver fails, you can load your settings to a replacement transceiver. If
the configuration file is not saved to a local or network drive, repeat the setup steps after
replacing a transceiver.

7 From the File menu, select File → Write Configuration to Device. Click OK.

CSS writes the configuration data to the device. The device stores the data its non-volatile
memory. When finished, a confirmation window appears.
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2.4.1.2
Configuration Screens
This table describes screens used while configuring the GTR 8000 Base Radio in the Configuration/
Service Software (CSS). For information on Time Division Multiple Access (TDMA) configurations, see
the Dynamic Dual Mode for TDMA Operation Feature Guide.

NOTICE:
• You may skip the shaded fields in this table, as the default values should be left as is.

• [R] designation on a field means a Restart is required if the field value is changed.

• An ASTRO® 25 Express System supports Phase 2 TDMA operation in the single-site
standalone system. X2-TDMA operation is not supported.

Table 8: Configuration Screens for the GTR 8000 Base Radio

Configura-
tion Screen Field Value

System WACN ID (hex) This field is not used for ASTRO® 25 Express single-
site systems.

System ID (hex) The identification number for the site. This number
must be unique within the site. Enter the hexadecimal
number that identifies the communications system in
which this base radio is located. Range is 001 (the de-
fault) through FFE.

Zone Grant Timeout Timer
(ms)

Default 1000. Specifies a time period for which an as-
signed voice channel remains active after access to
the channel is granted. Ranges from 400 ms to 6500
ms.

Carrier Fade Timeout
Timer (ms)

Default 1200. Specifies a time period for a voice chan-
nel to remain active if disconnect is not received from
a transmitting subscriber. Ranges from 100 ms to
6300 ms. If the Phase 2 TDMA feature is present in
your system, set the Carrier Fade Timeout Timer (ms)
field to 1900 for systems that have a value less than
1900. For systems that have a value greater than
1900, use the higher value entered for the system.

Site Site ID Enter the identification number for the site. This num-
ber must be unique within the site.

Site Name The name assigned to the site where the site control-
ler is located. Enter a name or alias for the site (up to
32 alphanumeric characters).

Access Code Index
Requested (hex)

The site uses the Access Code Index, together with
the System ID to calculate the Network Access Code
(NAC). The site generates and uses NACs so that
subscribers can communicate and ignore signals from
distant site or other systems.

MOSCAD IP The IP address of the MOSCAD NFM with which the
GTR 8000 Expandable Site Subsystem communi-
cates. Leave the default value of 0.0.0.0 in this field.

Table continued…
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Configura-
tion Screen Field Value

This field is not used for ASTRO® 25 Express single-
site systems.

Control Channel Slot
Time (microslots)

This field is used to enter the length of time (in micro-
slots) required for each control channel message
packet. The value can be from 1 to 40 with a default
value of 6 microslots. (One microslot is equal to 7.5
ms).

Zone Core Link Mini-
mum Jitter Buffer (ms)

Select a value (in ms) as the minimum jitter buffer time
for outbound audio, to account for network jitter on the
arriving XIS packets.

TDMA Mode [R] Specifies the mode of operation as either X2 TDMA or
Phase 2 TDMA. Choose Phase 2 TDMA for Frequen-
cy Division Multiple Access (FDMA) mode of opera-
tion.

NOTICE:
In an Express system X2 TDMA is not a val-
id selection.

Also, even for an FDMA-only mode of oper-
ation, when TDMA is not used, choose
Phase 2 TDMA.

Although 900 MHz is not supported in TDMA
mode, a 900 MHz station must be config-
ured via CSS for Phase 2 TDMA rather than
TDMA operation. This selection insures that
the DSP has the correct software image in-
stalled. Selection of TDMA makes the sta-
tion temporarily inoperative.

Channel Autocalculate Fre-
quencies (Not availa-
ble for UHF and VHF
bands.)

Enables or disables the Autocalculate Frequencies ca-
pabilities.

• If Enabled: the RX frequency is automatically set to
45 MHz below the Tx frequency in the 800 MHz
band, 30 MHz above the Tx frequency in the 700
MHz band and 39 MHz below the Tx frequency for
the 900 MHz band.

• If Disabled, type in all frequency values manually.

Tx Frequency (MHz) Enter the transmit frequency for the channel. For
700/800/900 MHz and UHF frequency bands, the Tx
Frequency value must be divisible by 6.25 kHz or 5.0
kHz to be valid. For VHF frequency bands, the Tx Fre-
quency value must be divisible by 6.25 kHz or 2.5 kHz
to be valid. The CSS displays the minimum and maxi-
mum frequencies. These frequencies are based on
hardware capabilities. See CSS Online Help for condi-
tions based on the frequency band.

X2/FDMA Tx Modula-
tion Type [R]

This field allows you to select the modulation type
used for all TDMA or Phase 1 FDMA transmissions

Table continued…
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Configura-
tion Screen Field Value

from this base radio. Phase 2 TDMA always uses the
H-DQPSK modulation mode and is not impacted by
the selection made here. Options are either ASTRO
CAI (LSM) or ASTRO CAI (C4FM).
If the Tx Modulation Type field is changed from C4FM
to LSM and the PA does not support the power level
values in the Tx Power Out and Tx Power Level Bat-
tery Backup fields, a popup appears and changes
those values to the maximum level supported by that
modulation type.

RX Frequency (MHz) If Autocalculate Frequencies are disabled, enter the
receive frequency for the channel. If the value is inva-
lid, the system displays a warning. For 700/800/900
MHz and UHF frequency bands, the RX Frequency
value must be divisible by 6.25 kHz or 5.0 kHz to be
valid. For VHF frequency bands, the Tx Frequency
value must be divisible by 6.25 kHz or 2.5 kHz to be
valid. The CSS displays the minimum and maximum
frequencies. These frequencies are based on hard-
ware capabilities.

RX Channel Band-
width

Default Narrow 12.5 kHz

Dual Branch Receive
Operations

For one branch of hardware, select Disabled. For two
branches of hardware, select Enabled. Enabled pro-
vides diversity operation for Phase 2 TDMA and re-
dundancy operation for FDMA. For details, see the
Dynamic Dual Mode for TDMA Operation Feature
Guide.

Packet Data Channel
Slot Time (microslots)

Default 10. Lets you enter the size of the Packet Data
Channel (PDCH) slot in units of micro slots. All sub-
scribers share the data channels. This field defines the
amount of time required to accurately indicate the
presence of a subscriber transmission on the PDCH.
This timer keeps subsequent subscribers from interfer-
ing with the inbound message attempt. This field is not
applicable to ASTRO® 25 Express single-site systems
and should be left at its default.

Base Station Identifi-
cation (Optional; if
blank, no BSI is trans-
mitted.)

Enter a Base Station ID for this base radio (up to 20
alphanumeric characters).

Signal Quality Delta Set the signal quality delta in decibels.

Time to Failure Set the time to failure value (in seconds).

Configuration
– Hardware
Configuration
Tab

Phase 1 FDMA, TDMA, CC, and Phase 2 TDMA sections:

Tx Power Out (Watts) This parameter requests the transmit power that
should be supplied by the channel PA. CSS also dis-
plays the actual transmit power output for the channel.

Table continued…
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Configura-
tion Screen Field Value

Tx Power Level Bat-
tery Backup (Watts)

This parameter indicates the transmit power that
should be used by the channel when running on bat-
tery backup. When running with battery backup, CSS
also displays the actual power level being output by
the channel.

Phase 2 TDMA section

Power Supply Type Select the power supply from the drop-down list.

Frequency Reference Default Integrated References A/B. Specifies the
source of the frequency reference for the system.

Time Reference Specifies the source of the time reference for the sys-
tem.

Battery Type Select a battery type from the drop-down list. This field
indicates the type of storage battery used so the pow-
er supply circuitry can select the best charging rate.
Whenever AC power is lost, the channel uses the Tx
Power Level Battery Backup value.

This following parameters support the Transceiver Option Card (TOC):

Transceiver Option
Card Actual

This read-only field is set from the CSS when a TOC
is Detected or Not Detected.

Transceiver Option
Card [R]

Select whether a TOC is Enabled or Disabled.
This field works with the TOC Actual parameter.

Fall Back to Internal
Frequency Reference

Select Enabled to use the alternative Internal Fre-
quency when the external frequency reference fails.
This default is Disabled. Dependency: This field is on-
ly accessible under the following conditions:

• TOC is set to Enabled
• Frequency Reference is NOT set toIntegrated Fre-

quency Reference

Configuration
– Station Con-
figuration Tab

Station Name Enter a name or alias for this base radio (up to 32 al-
phanumeric characters).

ASTRO Fade Toler-
ance (Frames)

Enter the number of missed frame syncs (in a row) be-
fore a call is terminated. Default is 3.

Dynamic Frequency
Blocking Capability

Leave the default value.

Failsoft Capable Enable or disable this feature. Enabled means that
this channel can have up to seven interfering channels
and that this channel can operate in failsoft mode. Al-
so, this channel can be an interfering channel for an-
other channel. Disabled means that this channel can-
not operate in failsoft mode.

Serviceability Fault
Reporting

This function is not supported in ASTRO® 25 Express
single-site systems and should be set to “Disabled”.

Table continued…
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Configura-
tion Screen Field Value

Illegal Carrier Determi-
nation

Default Enabled. The illegal carrier determination fea-
ture allows the channel to detect and respond to un-
recognized signaling on the channel that exceeds a
particular threshold for at least a certain amount of
time. The system can detect an Illegal carrier, using
the value in the RF Threshold Value (dBm) field.

RF Threshold Value
(dBm)

Default depends on the RF band. The RF threshold
parameter determines the minimum RF signal level is
recognized before classifying an illegal carrier event
and reporting an alarm to the Technician log.

Set Default RF
Threshold

Select button (while connected to base radio) to set
RF Threshold to its default value.

Malfunction Timer Val-
ue (seconds)

When Illegal Carrier Determination is checked, this
field allows you to specify the length of time (in sec-
onds) a signal must continuously exceed the RF
Threshold Value (dBm) before being reported as an il-
legal carrier and removed from system use. Default
50.

Configuration
– Infrastruc-
ture Interface
Tab

Ethernet Type Allows you to select the duplex and speed for the
channels Ethernet connection. Choose 10 Mbit, half-
duplex (the default) or 100 Mbit, full-duplex.
Changing Duplex Settings from 100 Full to 10 Half re-
sults in loss of connectivity for a short time, and CSS
may report an error. Reading the CSS Configuration
again should restore the connectivity.

Configuration
– Receiver
Multicoupler
Configuration
Tab

GTR 8000 Configura-
tion

Select GTR 8000 Expandable Site Subsystem

Site Receiver Multi-
coupler Configuration
(RMC) Configuration

Specifies whether a Site RMC is installed.

Site RMC Attenuation Automatically calculated

Cabinet RMC Configu-
ration

Automatically set

Cabinet RMC Attenua-
tion

Automatically calculated

System Gain (dB) Automatically calculated

2.5
GCP 8000 Site Controller Configuration Setup
This section describes the GCP 8000 Site Controller configuration.
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2.5.1
Configuring the GCP 8000 Site Controller Using CSS
Use this process to configure the GCP 8000 Site Controller for an ASTRO® 25 Express System using
the Configuration/Service Software (CSS).

Process:
1 Launch the Configuration/Service Software (CSS) application. See CSS Online Help, “Process

to Configure a Repeater Site Subsystem”.

2 From the Help menu, select CSS Help.

3 In the Contents, expand the ASTRO 25 Express System option and select the Process topic.

4 Perform Step 1 of the Process. The link opens in a new browser window, displaying the Site
Controller Online Help.

5 In Site Controller Online Help, expand the ASTRO 25 Express System option.

6 Open the Process to Configure the ASTRO 25 Express System Site Controller topic. See
CSS Online Help, “Process to Configure the ASTRO 25 Express System Site Controller”.

Figure 12: Process to Configure the ASTRO 25 Express System Site Controller

Configuration Screens for the GCP 8000 Site Controller are listed in GCP 8000 Site Controller
Configuration Screens on page 43.

2.5.2
GCP 8000 Site Controller Configuration Screens
The following screens are used while configuring the GCP 8000 Site Controller in the Configuration/
Service Software (CSS).
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NOTICE: Skip the shaded fields in this table, as the default values should be left as is.

Table 9: GCP 8000 Site Controller Configuration Screens

Configuration
Screen Field Value

System WACN ID (hex) Enter a unique ID for the Wide Area Communications
Network. Hexadecimal range of values is 00001 through
FFFFE.

Sub-Band –
Radio Tab

Number of Valid Entries Consult Fleetmap or System Administrator. Up to 128
are allowed.

Lower Radio ID Consult Fleetmap or System Administrator.

Upper Radio ID Consult Fleetmap or System Administrator.

Subband Restricted Consult Fleetmap or System Administrator.

Sub-Band –
Talkgroup Tab

Number of Valid Entries Consult Fleetmap or System Administrator. Up to 128
are allowed.

Lower Talkgroup ID Consult Fleetmap or System Administrator.

Upper Talkgroup ID Consult Fleetmap or System Administrator.

Subband Restricted Consult Fleetmap or System Administrator.

Band Plan
Configuration
–Band Plan In-
formation Tab

Band Plan ID Consult Fleetmap or System Administrator. Up to 20 are
allowed.

Band Plan Name Enter a name or alias (up to 32 alphanumeric charac-
ters).

Band Plan
Configuration
–Frequency
Band Plan Tab

Index Automatic defaults entered for Index 1 to 4

Identifier Enable Click the check box to enable the Band Plan Index en-
try. Deselect check box for Index 3 and Index 4; X2-
Time Division Multiple Access (TDMA) is not supported
in ASTRO® 25 Express system.

Channel Type Frequency Division Multiple Access (FDMA) or TDMA

Base Frequency (MHz) Enter the base frequency for the Band Plan Index en-
try. Value must adhere to the frequency ranges allowed
for your type of ASTRO® 25 Express system.

Channel Spacing (kHz) Enter the frequency difference between two consecutive
channels. Value must adhere to the channel spacing re-
quirements for your frequency band.

Tx/Rx Offset (kHz) Enter the frequency difference between the transmit fre-
quency and receive frequency.

Zone RX Bandwidth (kHz) 12.5 (the default)

RFSS ID (Zone ID) Default 1

ZC IP Address 1 Default 0.0.0.0

ZC IP Address 2 Default 0.0.0.0
Table continued…
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Configuration
Screen Field Value

Site – Site
Configuration
Tab

Site ID Default 1

Link Debounce Timer
(sec)

Default 3

IMPORTANT: Changing the value of the Link
Debounce Timer field from its default value of
3 seconds may affect the site recovery time in
a system configuration for Dynamic System
Resilience (DSR).

Trunk Recovery Timeout
Timer (sec)

Default 5

Site Name Enter a name or alias (up to 16 alphanumeric charac-
ters) for this site.

Site Trunking Indication
Holdoff Time (sec)

Default 0

Site Trunking Indication
Holdoff Time Actual (sec)

Default 0

Site Trunking Priority
Monitoring Override

Select Enable to allow all talkgroups to be priority moni-
tor-capable in Site Trunking. Default is Disabled.

Site Trunking Indication
Override

Select Enabled to prevent the Site from transmitting site
trunking indications to subscriber radios. Select Disa-
bled to allow transmission of site trunking indications to
subscriber radios.

In-Call User Alert Choose to Enable or Disable this feature. Default is
Disabled.

Site Call Load Capacity
Override

This field allows you to determine if the Site Call Load
Capacity parameter value is auto-calculated by CSS or
overridden by a user-specified value. Default is disa-
bled.

CAUTION: Do not override the calculated val-
ue for the Site Call Load Capacity parameter
because it can have a major impact on system
performance. Contact Motorola Solutions Sup-
port Center (SSC) for guidance on making any
manual changes to this parameter.

Site Call Load Capacity This field allows you to define the maximum limit of the
number of simultaneous calls handled by the site. The
range of values for this field is 10-30, with a default val-
ue of 30. CSS displays the current value of this field on
the Channel screen. When the value is changed, either
automatically or manually, the Channel screens (table
view only) Site Call Load Capacity (read-only) field is
updated to the same value.

TDMA Mode Phase 2 TDMA

Reporting on X2 Only Ra-
dio

The default is Disabled

Table continued…
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Configuration
Screen Field Value

Minimum Repeater to
Trunk

This parameter supports the Minimum Channel to Fail-
soft feature for an Express Expandable Site Subsystem
in a non-simulcast Trunked configuration. Configure the
minimum number of channels that must remain opera-
tional for the site to function in Trunked mode.

When the number of operational channels at the site in
a non-Simulcast system is less than the value config-
ured for the “Minimum Repeaters To Trunk”, the site im-
mediately goes into RF Site Failsoft Mode. Otherwise,
as long as the number of operational channels is equal
to or greater than the value configured, the site operates
in Trunked Mode.

The allowable range of values is 2 to 28, with a default
value of 2.

Site – Daylight
Saving Time
Tab

Offset Time from Local to
GMT

Select a value for the number of hours added to or sub-
tracted from Greenwich Mean Time to equal the local
time.

Automatic Adjust for DST Choose Enabled or Disabled to allow the site controller
to automatically adjust for Daylight Saving Time.

Daylight Saving Start Select which week of the month, the day of the week,
the month of the year, and the hour at which Daylight
Saving Time starts.

Daylight Saving End Select which week of the month, the day of the week,
the month of the year, and the hour at which Daylight
Saving Time ends.

Daylight Saving Time Shif-
ted

Select a value (in hours: minutes format) for the amount
of time that shifts while Daylight Saving Time is in effect.

Channel Channel number Select a Channel number to configure. (Only Channel 1
through 18 can be configured for an ASTRO® 25 Ex-
press system.)

Channel Configuration If the channel number selected is used in the system,
select Configured.

BSI Calling If the channel is set to BSI Capable, enter a base Sta-
tion ID Calling (up to 20 alphanumeric characters,
though only the first 8 characters are transmitted).

Control Channel Prefer-
ence Level

If Channel is set to Control Channel Capable, enter a
value as the preference level that this channel is used
as the control channel at the site. Value can be 1
through 4, with 1 as the highest preference and 4 as the
lowest.

Sub-Band Choose Enabled to allow this channel to be assigned to
sub-band frequencies.

Channel Assignment Type Select the type of channel grant used for other band
trunking, either Explicit or Implicit (the default).

DFB Capable This field should be left at default.
Table continued…
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Configuration
Screen Field Value

BSI Capable Choose Enabled to allow transmit of a Base Station
Identification Calling. (Cannot enable on a control chan-
nel.)

Failsoft Capable Choose Enabled to allow this channel to operate in Fail-
soft mode.

Control Channel Capable Choose Enabled to designate this channel as a control
channel. Only Channels 1 through 4 can be designated
as control channel capable.

Protect Capable Default Disabled

Voice Capable Choose Enabled to allow this channel to be assigned as
a voice channel.

TX Channel Freq (MHz) Enter the transmit frequency (in MHz) for this channel.

FDMA TX Band Plan Ele-
ment

Enter the Index number to associate this channel with
an element in the Frequency Band Plan table.

RX Channel Freq (MHz) Enter the receive frequency (in MHz) for this channel.

FDMA RX Band Plan Ele-
ment

Enter the Index number to associate this channel with
an element in the Frequency Band Plan table.

TDMA Tx Band Plan Ele-
ment

An index number to associate this channel with an ele-
ment in the Frequency Band Plan table (where the band
plan Channel Type is TDMA). The range of values is 1
to 16 with a default value of 3.

TDMA RX Band Plan Ele-
ment

An index number to associate this channel with an ele-
ment in the Frequency Band Plan table (where the band
plan Channel Type is TDMA). The range of values is 1
to 16 with a default value of 3.

Channel Access Type TDMA Only, or Dynamic Channel, or FDMA Only

Configuration Controller Name Enter a name (up to 32 alphanumeric characters) for the
site controller.

Hardware Platform GCP 8000

Site Platform Type GTR 8000

Time Reference 1PPS

Power Supply Type Re-
quested

Choose the type of power supply from the drop-down
list.

Battery Type Select a battery type from the drop-down list or choose
None.

Table continued…

MN004282A01-A
Chapter 2:  Equipment Setup

Send Feedback   47

http://docsurvey.motorolasolutions.com


Configuration
Screen Field Value

Site Controller
Switch – Local
Switch Tab.
Match the
fields to this
example.

Figure 13: Site Controller Switch Window – Local Switch Tab

Site Controller
Switch – XHub
1, and so on.
Match the
fields to this
example.

Figure 14: Site Controller Switch Window – XHub 1 Tab

2.6
Subscriber Radios Setup
Follow this section to configure subscriber radios.
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2.6.1
XTS 5000 Portable or XTL 5000 Mobile Subscribers Configuration
The XTS 5000 Portable or XTL 5000 Mobile subscribers are configured using the Customer
Programming Software (CPS) for the radio model. The following parameters must be set using CPS.
Shaded parameters are required if implementing radio-to-radio encryption. Skip the shaded
parameters if encryption is not being implemented.

Table 10: Subscriber Configuration Parameters

Parameter Option Value

Trunking Trunking Con-
figuration

SmartZone Display Site
Trunking

Default checked (leave as de-
fault)

Alert Site Trunk-
ing

Default checked (leave as de-
fault)

Trunking Sys-
tem

General Type ASTRO 25

Home System
ID

Customer specific

Home WACN ID Customer specific

Unit ID The ID of the subscriber unit

Coverage Type Disabled

ASTRO 25
Channel ID

Entire band plan
as defined in
site controller

ASTRO 25
Control Chan-
nels

Frequencies of
possible control
channels

Trunking Per-
sonality

General Protocol Type ASTRO 25

System ID Pointer to the Trunking Sys-
tem created

Emergency Console Ack
Required

Unchecked

Talkgroup List of talk-
groups with IDs

Hexadecimal value of talk-
group IDs (example 800015 is
hex F)

Secure/Clear
strapping

Choose if talkgroup permits
only encrypted calls, only
clear calls, or both clear and
secure

Key Select Select which keys from the
Secure Multikey List are used

Channel
Assignment

Channels Selector posi-
tions

Associate selec-
tor positions
with personali-
ties and talk-
groups created

Table continued…
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Parameter Option Value

in the “talk-
group” section.

Radio Con-
figuration

Secure Con-
figuration

General Secure equip-
ped

Checked

Secure Type Hardware (for Advanced Digi-
tal Privacy (ADP) radios)

Secure Multi-
key List

Common Key
Reference
(CKR)

Enter CKR
numbers and
aliases

The encryption keys which are
assigned to talkgroups.
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Chapter 3

Test and Verification
The chapter provides a list of recommended test equipment along with activities necessary to support
performance testing and verification for the GTR 8000 Base Radio and Radio Frequency Distribution
System (RFDS) activities.

IMPORTANT:
Prepare and set up the site and site equipment properly, and verify all safety and installation
considerations and requirements are addressed before system test and verification activities.

Test the operation of the system by making calls from the subscriber units and ensuring call
completion and quality. Contact your System Administrator for the specific parameters for
subscribers, talkgroups, frequency bands, and channels.

3.1
Test and Verification Requirements, Setup, and Procedures
The following test requires recording of various measurements. Many measurements in this process
are calculated and require the use of the provided Excel spreadsheet. The following two performance
parameters calculated during this process are critical for the system to meet coverage requirements:

• Transmit Effective Radiated Power (ERP)

• Receive Effective Receive Sensitivity (ERS)

IMPORTANT: Any personnel performing test and verification process activities must review all
the information provided in this document before performing these activities. To perform these
activities, familiarity with the Configuration/Service Software (CSS) application is required and
the CSS Online help used to support these activities.

The GTR 8000 Expandable Site Subsystem is optimized at the factory and no major adjustments are
required. See the following sections for more details.

3.1.1
Required Test Equipment and Tools
The test and verification activities are based on the use of the following equipment. Your test
equipment may vary. See the manufacturer for detailed information regarding the use and operation of
all test equipment.

• Aeroflex/IFR 2975 or 3900 series Communications Analyzer with P25 Option

NOTICE: The 2975 requires software version 1.9.2.1 or greater, and it needs an external 20
dB TNC attenuator installed on the Gen Port (MECA 612-20-3 or Pasternack PE7003-20).

• Portable Rubidium frequency standard (Stanford Research Systems FS725) or for Simulcast Sites
with an FDM module installed in the TRAK 9100.

• Rohde&Schwarz NRT-Z14 Directional Power Sensor with NRT-Z5 USB Adapter. It has sufficient
accuracy if used with the recommended test setup to verify base radio Tx rated power within
published specifications. If the station is operating according to specifications, other wattmeters may
not be able to provide consistent enough results to determine. The following can be substituted, but
out-of-tolerance results are likely due to the other wattmeter:

- A wattmeter with LSM, H-DQPSK, and C4FM with N-f QC connectors:

+ Wattmeter with APM-100 Element in the correct frequency band
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+ Wattmeter with APM-50 Element

+ Wattmeter with APM-5 or APM-10 Element

- A wattmeter with C4FM ONLY with N-f QC connectors:

+ Wattmeter 100 Element in the correct frequency band

+ Wattmeter 50 Element in the correct frequency band

+ Wattmeter 5 or 10 Element

• 150 W or greater, 30 dB or 40 dB RF Attenuator (RF-Lambda RFS150G02, JFW 50FHAO-030-200)

• QN-f to N-m test cable (QFNM-24, TestedRFCables)

• N-m to 7/16-m adapter

• N-m to 7/16-f adapter

• 20 dB or 30 dB directional coupler (Mini-Circuits ZFDC-20-4-N)

• Service laptop computer with Configuration/Service Software (CSS)

NOTICE: If your service laptop is running a firewall (Black Ice, Symantec, Zone Alarm, and
so on), you may have to configure or stop the firewall during this procedure. The service
laptop must be configured as a Dynamic Host Configuration Protocol (DHCP) client.

3.1.2
Setting up the Aeroflex/IFR Analyzers
The Aeroflex/IFR analyzers support remote operation with a laptop. For remote operation, configure
the analyzer as a Dynamic Host Configuration Protocol (DHCP) client.

Procedure:
1 If you are not using remote operation, connect a mouse to the analyzer before powering up.

2 Turn on the analyzer (and the FS725 portable Rb standard if used) and allow them to warm up.
If using the FS725 portable Rb standard, check that the lock indicator is on after 20 minutes.

3 Connect the laptop and (if using remote operation) the analyzer to port 20 - 24 of the external
RF site switch with a standard Ethernet cable.

If no external site switch is available, use the Net Aux port on top of the cabinet, and connect
this port to a temporary test switch that you provide. If the external site switch ports are locked
down, a convenient connectivity solution is to disconnect a non-critical device during
optimization and connect a temporary test switch to this port. This solution provides ports
available to support the laptop and analyzer. For systems using advanced information
assurance policies, work with the appropriate resource to gain access to the site switch.

4 Remove the site link connection to isolate the site from the rest of the system, which ensures
that the base radios at this site cannot be remotely keyed up.

CAUTION: If step 4 is performed on a live system, the channel should be disabled before
removing the link.

5 Connect a BNC-m to BNC-m cable from the frequency standard (TRAK 9100 with FDM or SRS
FS725) 10 MHz output to the analyzer EXT REF I/O.

NOTICE: After recalling the analyzer test setup, configure the analyzer to use the
external frequency reference.

6 If using a wattmeter not a Rohde&Schwarz, install the 100 W element into the wattmeter, and for
the APM-16, use the battery test position to verify that the battery is satisfactory. Turn the
wattmeter ON. Check the wattmeter meter zero reading and adjust if needed.
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7 Start recording the project, site, T and ME, and balance of the antenna data on the test result
sheets.

3.1.3
Configuring the Analyzer
Perform this procedure to configuring the analyzer for testing.

Procedure:
1 Recall the 12 - P25-Test configuration file from the 3900 Samples directory.

The setup should look like the screen shown in this figure. If the Aeroflex 3900 does not recall
the meter tile correctly, you may need to manually edit the meters. See the manufacturer
documentation.

Figure 15: RF Control Screen

2 Change the Communications Analyzer frequency reference to External.
3 For each channel tested, set the Analyzer receiver frequency equal to the base radio Tx

frequency.

4 For each channel tested, set the Analyzer receiver frequency equal to the base radio RX
frequency.

3.1.4
Testing RF Connections for the Analyzer
Perform this procedure to test the RF connections for the analyzer.

Procedure:
1 For the RX test connections, connect a TNC-male to an N-male test cable with known loss from

the Analyzer Gen Port to the Primary Rack Receive Input Branch ‘A’ connector (on top of the
junction panel).
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Leave this connection in place for all the channels tied to this RX antenna. For multiple RX
antennas, move the connection to the other junction panel when needed.

Figure 16: Receive Input

2 To make Tx test connections, perform the following actions:

a Disconnect the base radio Tx Output QN connector where it connects to the Tx combiner
input.

b Connect the base radio Tx Output QN connector to a female QN adapter or test cable with
known loss.

c Connect the other end of the test cable or adapter to the wattmeter input.

d Connect the wattmeter output to the high-power RF Attenuator input.

e Connect the RF Attenuator output to the Analyzer T/R input using N cables.

NOTICE: This connection changes for each base radio tested.

Figure 17: Tx Test Connections

3 Use this figure to verify the Tx and RX test connections.
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Figure 18: GTR 8000 Expandable Site Subsystem Test Setup

3.1.5
Testing the Base Radio
Performing base radio tests involves the following base radio test activities.

Process:
1 Perform a preliminary testing setup of the base radio. See Configuring Preliminary Base Radio

Settings on page 55.

2 Test the base radio transmitter. See Testing the Transmitter on page 56.

3 Test the base radio receiver. See Testing the Receiver for FDMA Operation on page 58 or 
Testing the Receiver for APCO TDMA Operation on page 60.

3.1.5.1
Configuring Preliminary Base Radio Settings
Perform this procedure to configure the base radio to prepare it for testing.

Procedure:
1 Using the service laptop and the Configuration/Service Software (CSS) application, connect and

read the base radio configuration (codeplug).

2 Identify and verify base radio configuration settings.

When moving to different channels, disconnect the CSS session by pressing CTRL+K from the
base radio to which you are currently connected. If necessary, you can reconnect to the base
radio later in the procedure. If a message appears stating the base radio is connected to another
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device, shut down and restart the CSS or the base radio. Again, read the base radio
configuration.

3 From the system tree, select Configuration → Hardware Configuration Tab.

4 Set Tx power out (Watts) to the rated power (See “Rate Power” table).

5 Select the Station Configuration tab and perform the following actions:

a Set Illegal Carrier Determination to Enabled.

b Set Illegal Carrier Determination RF Threshold (dBm) to the default value.

c Check that simulcast operation matches your site.

6 Select the Receiver Multicoupler (RMC) Configuration tab.

The RX specification for sensitivity of the Expandable Site Subsystem configuration is
predicated on the cabinet and, if present, the Site RMC being configured for operation without a
Tower Top Amplifier (TTA).

7 Verify that the Receiver Multicoupler (RMC) Configuration tab in the CSS Configuration
window matches the hardware configuration and attenuator values. Ensure that the RMC
attenuators are initially set in accordance with the table.

Table 11: Attenuator Values of GTR 8000 Expandable Site Subsystem with No TTA

Band TTA Cabinet Site RMC Cabinet RMC

UHF No Single N/A 1 dB

UHF No Multiple 4 dB 15 dB

700/800 No Single N/A 0 dB

700/800 No Multiple 1 dB 10 dB

8 Ensure the RMC configuration in the CSS matches the actual installation.

If… Then…

If a site RMC
is installed...

perform the following actions:

a In CSS, set the Site RMC Configuration as Installed.

b Set the Site RMC Attenuation value to match those values as estab-
lished from the actual DIP switches.

c Set the Cabinet RMC Attenuation value the same as its actual DIP
switches.

9 Save the configuration changes to the base radio by performing the following actions:

a From the menu, select File → Write Configuration To Device.

b Click OK on the confirmation window.

NOTICE: If a TTA is installed at the site, re-configure the settings in the CSS Receiver
Multicoupler (RMC) Configuration tab in another activity in this process (TTA test
section).

3.1.5.2
Testing the Transmitter
Perform this procedure to test the base radio transmitter.
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Procedure:
1 Perform the following actions to perform the Transmitter Test (Internal Diagnostic) test.

a From the Configuration/Service Software (CSS) menu, select Service → Metering Screen.

b Select the Transmitter tab.

If the test fails, diagnose and correct the problem before continuing with this base radio.

c Click Transmitter Test.
d From the menu, select Service → Test and Measurement Screen.

e In the Test and Measurement screen, if the radio is not in service mode, click Change to
Service Mode.

f When the confirmation dialog box appears, click OK.

The base radio begins a reset sequence to change modes, which take several minutes.

g After the base radio resets, re-open the Test and Measurement screen.

2 Perform the following actions to check the Rated Power.

a Identify the appropriate value from the table, and record the power and In Cable Loss value.

Table 12: Rated Power

Band >> 700/800 UHF R2 UHF R1 VHF

Frequency
Range

762-776
851-870

450-512 380-435 136-174

Power C4FM 100 W 110 W 110 W 100 W

Power LSM 100 W 100 W 100 W 60 W

Int Cable Loss 0.18 dB 0.13 dB 0.13 dB 0.04 dB

Set the CSS Tx Power Output Watts field for the rated power.

b Key the base radio with a V.52 test pattern. In CSS, select the ASTRO Test Patterns tab
and set the Select Pattern to Transmitfield to V.52 or V.52 Frequency Division Multiple
Access (FDMA). Click Start Pattern Transmission. Leave the station keyed until instructed
to de-key it.

c Record the Power Sensor or wattmeter reading and calculate for the cable losses to
determinate the Rated Power Corrected result.

d Verify that the Rated Power Corrected result is within ±10% of the Base Radio Tx Rated
Power. If using a wattmeter that is not a Rohde&Schwarz, you may not be within ±10%.

3 Perform the following actions to check the Frequency Error.

Use an external 10 MHz reference source, capable of delivering 10-18 dBm (2-5 Vpp) to the
Front Panel Ext. Freq Ref BNC connector, with a suitable frequency accuracy to perform this
activity. See the GTR 8000 Expandable Site Subsystem Feature Guide for port connections.

a Record the Frequency Error value and calculate the resulting error in parts per billion (ppb).

b Verify that the calculated Frequency Error in ppb is within the specification (≤ 2.5 ppb for
Simulcast, ≤ 9.5 ppb for a single site).

c For a single site, if the Frequency Error is out of tolerance, perform the site controller
reference oscillator alignment as documented in the CSS.

4 Perform the following actions to check the Tx Bit Error Rate (BER).
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a After 30 seconds, record the Analyzer UUT Tx Bit BER value.

b Verify that the Tx BER is ≤ 0.01%.

If the Tx BER test fails, ensure that the analyzer is correctly configured to decode the V.52
test pattern. This test pattern name can be called O.153 or STD511 in the test equipment.
For the 3900, expand the UUT Measurements pane to access this setting.

5 Perform the following actions to check the Modulation Fidelity.

a On the Analyzer, qualitatively assess the Constellation (3900 Only) and the Eye Diagram.
The 4-level eye diagram and constellation plot should look like the patterns shown on the
Analyzer Figure 15: RF Control Screen on page 53 in the Test Equipment → Analyzer
Configuration (3900) section.

b Monitor the Mod Fidelity value for 30 seconds, then note and record the highest reading.

c Verify that the Modulation Fidelity reading is < 5%.

6 Perform the following actions to check the Symbol Deviation.

a On the Analyzer, identify the Symbol Deviation value and record the value.

b Verify that the Symbol Deviation is 1800 Hz ± 5% (1710 Hz to 1890 Hz).

7 Perform the following actions to check the Symbol Rate Accuracy (Clock Error).

a On the Analyzer, identify the Symbol Clock Error value (3900 series only) and record the
value.

b Verify that the Symbol Clock Error is ≤ 48 MHz (±10 ppm).

c From the CSS menu, select Service → Test and Measurement Screen.

d From the Test and Measurement screen, click the ASTRO Test Pattern tab. Click Stop
Pattern Transmission to stop the Pattern Transmission Tests.

Manually disable the test pattern as a base radio resets. Do not disable the test pattern.

e Verify that the transmitter has de-keyed by observing that the wattmeter now reads 0.

3.1.5.3
Testing the Receiver for FDMA Operation
Perform this procedure to test the base radio receiver.

Procedure:
1 Perform the following actions to perform the Receiver Test (Internal Diagnostic).

a From the Configuration/Service Software (CSS) menu, select Service → Test And
Measurement Screen.

b From the Test And Measurement Screen, click the ASTRO BER & RSSI Report tab.

c Click Start Receiver Test.
d Wait a few seconds for the test to conclude, then record the Pass or Fail result. If the test

fails, troubleshoot and repair before proceeding.

2 Perform the following actions to check the Received Signal Strength Indication (RSSI) Direct into
the Receiver.

a Turn on the Analyzer Generator if not enabled.

b Establish an Analyzer Generate RF Level that produces a level of –47.0 dBm into the RX
Input. Account for test cable loss. Generate Level = –47 dBm + test cable loss.

c Under the Settings area, select Project 25 in the Pattern Type and establish the Sampling
Period as 10 seconds.

MN004282A01-A
Chapter 3:  Test and Verification

58  Send Feedback

http://docsurvey.motorolasolutions.com


IMPORTANT: Use the RSSI Measurement function in the CSS to verify RSSI levels,
though the Bit Error Rate (BER) function displays RSSI.

d Start the RSSI Measurement Test. Click Start RSSI Measurement.
e Wait for 30 seconds and record the CSS Received Signal Strength (dBm) value.

f Click Stop RSSI Measurement.
g Verify that the RSSI Direct value is within specifications: –47 dBm –2 dB to + 5.25 dB (–49

dBm to –43.75 dBm).

3 Perform the following actions to check Rx Bit Error Rate (BER) Calibration.

a Set the Analyzer Generate test pattern to STDCAL and CSS Pattern type as Project 25.

b Click Start BER Measurement.
c After 30 seconds, record the CSS BER % value.

d Verify that the Rx BER Calibration BER % is 4.977% ±0.01% (4.967% to 4.987%).

4 Perform the following actions to check Rx BER Floor.

a Set the Analyzer Generate test pattern to STD 1011 and CSS Pattern type as Project 25.

b After 30 seconds, record the CSS BER % value.

c Click Stop BER Measurement.
d Verify that the Rx BER Floor BER % is ≤ 0.01%.

5 For GTR 8000 Expandable Site Subsystem only: Perform the following actions to check the
Sensitivity Direct into the Receiver.

The Rx sensitivity specification values are correct only when the Remote Multicouplers (RMCs)
are configured as detailed in Configuring Preliminary Base Radio Settings on page 55. If the
RMC attenuation is changed, as for a Tower Top Amplifier (TTA), the base radios may no longer
meet this specification. This situation does not mean that the base radio is defective, but that the
RMC gain is part of this specification, and if the RMC gain is changed, the sensitivity of the base
radio also changes.

Table 13: Rx Sensitivity Specifications

This table provides the Rx Sensitivity specifications (after accounting for cable losses) for each
band and frequency range:

Band 700/800 UHF R2 UHF R1 VHF

Frequency
Range

792-825 450-512 380-435 136-174

Specifica-
tion

-123 dBm -121.5 dBm -115.5 dBm -117 dBm

a Record the appropriate sensitivity specification.

b In the Test and Measurement screen, click the ASTRO BER RSSI Report tab.

c Under the Settings area, set the Sampling Period as 1 second.

d Click Start BER Measurement.
e Adjust the Analyzer Generate RF Level for a CSS Bit Error Rate of 5% ± 0.25%.

f Record the Analyzer Generate Level and calculate the corrected sensitivity accounting for
cable loss.

g Click Stop BER Measurement.
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h Click Start RSSI Measurement.
i Record the CSS RSSI (dBm) value.

j Click Stop RSSI Measurement.
k Verify that the Sensitivity Corrected value is < Specification + 1 dB. The Sensitivity RSSI

value is a relative value that may prove useful for troubleshooting.

l Disconnect the Tx test cable from the base radio Tx output connector and restore the normal
connection to the Tx combiner input.

m Terminate the CSS session with the base radio by pressing CTRL+K.

n Repeat the test activities on the remaining base radios at the site, see Testing the Base
Radio on page 55. After completing the base radio testing, continue with Testing the RFDS
on page 60.

6 If Rx B is used as a backup and the site is not TDMA:

a Disconnect the test cable from the generator to Rx A at the base radio and connect it to Rx
B.

b Increase the generator level to -47 dBm.

c Wait for Branch A to fail.

• This can take up to two (2) minutes.

• CSS Channel tab Time to Failure (sec) field controls the time to fail.

d Repeat step 5 of this procedure.

3.1.5.4
Testing the Receiver for APCO TDMA Operation
See chapter 5 in the Dynamic Dual Mode for TDMA Operation Feature Guide for TDMA testing using
the Aeroflex service monitor.

To perform a self-test of the receiver's sensitivity, see “Checking the Receiver Sensitivity (Self-test
Method)” in chapter 5 of the GTR 8000 Expandable Site Subsystem Feature Guide.

3.1.6
Testing the RFDS
Performing this process to test the Radio Frequency Distribution System (RFDS).

Procedure:
1 Test the transmit (TX) RFDS output at rated power. See Testing TX RFDS Output at Rated

Power on page 60.

2 Establish the TX Effective Radiated Power (ERP) and set the base radio power output. See 
Establishing TX ERP and Setting Base Radio Power Output on page 63.

3 Test the receive (RX) capability on systems with a Tower Top Amplifier (TTA). See Testing RX
with a Tower Top Amplifier (TTA) on page 64.

4 Test the receive (RX) capability on systems without a TTA. See Testing RX without a Tower Top
Amplifier (TTA) on page 68

3.1.6.1
Testing TX RFDS Output at Rated Power
Perform this procedure to test the transmit (TX) Radio Frequency Distribution System (RFDS) output at
rated power.
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Procedure:
1 Configure the RFDS TX test setup as shown in this figure.

Figure 19: TX RFDS Test Setup

2 Tune the combiner.

3 To check TX RFDS output at rated power, identify and record the TX RFDS Max Loss in dB
specification from the following table:

The base radio specification for this activity is to produce no less than the specified RFDS Max
Loss for a given RFDS configuration. This table shows the overall TX RFDS loss in dB from the
base radio TX output to the cabinet TX output. Calculate the actual TX RFDS Insertion Loss.
Ensure that the calculated value is less than or equal to the TX RFDS Max Loss value.

Table 14: TX RFDS Loss (in dB)

Band: 800 On-
ly 800 Only 700 On-

ly 700 Only 700/800 On-
ly UHF R2

Range: 851 –
870

851 – 870 762 –
776

762 – 776 762 – 870 450 -
512

1 or 2 Combin-
ers:

6 Ch 12 Ch 6 Ch 12 Ch 12 Ch 6 Ch

Table continued…
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Band: 800 On-
ly 800 Only 700 On-

ly 700 Only 700/800 On-
ly UHF R2

150 kHz Spac-
ing:

4.0 4.3 4.0 4.3 4.7 5.1

250 kHz Spac-
ing:

3.5 3.8 3.5 3.8 4.2 4.5

500 kHz Spac-
ing:

3.3 3.6 3.3 3.6 4.0 4.1

3000 kHz
Spacing:

3.2 3.5 3.2 3.5 3.9 N/A

4 Perform the following actions to measure the RF power at the Primary Rack TX Connector.

a Install wattmeter inline (to read forward power). If using a wattmeter other than a
Rohde&Schwarz, use the 50 Watt element.

b Connect to the base radio and read the configuration (codeplug) by pressing CTRL+R.

c From the Configuration/Service Software (CSS) menu, select Service → Test and
Measurement Screen.

d From the Test and Measurement screen, if the base radio is not in Service Mode, click
Change to Service Mode.

e From the confirmation dialog box, click OK.

The base radio begins a reset sequence to change modes, which take a few minutes.

f After the base radio resets, re-open the Test and Measurement screen.

g Key the base radio (V.52). Select the Start Pattern Transmission button.

h Record the wattmeter reading.

i If using a wattmeter other than a Rohde&Schwarz, perform the next three actions. Otherwise,
proceed to step 4 j.

1 De-key the base radio and verify that the wattmeter reading drops to zero.

2 Install the 5 W or 10 W wattmeter element to read reflected power.

CAUTION: Orient the element correctly to read reverse (reflected) power,
otherwise damage may occur.

NOTICE: If the station is left keyed up, the forward power reading may change
over time. This behavior is normal for the ceramic cavities used in this combiner.
Even if the power reading drops over time, it still meets its published specification.

3 Key the base radio (V.52). Click Start Pattern Transmission.

j Record the reverse power reading. If the reflected power is greater than 5 W, correct the
antenna, line, protector, or jumper that may be resulting in an unacceptable reflected power.

k De-Key the base radio. Click Stop Pattern Transmission and verify that the wattmeter
drops to zero.

l If using a wattmeter other than a Rohde&Schwarz, re-install the 50 W element in the
wattmeter (orient to read forward power).

m Verify the RFDS Rated Forward Power > specified RFDS Power Output – 8.1% and the
Return Loss (VSWR) at the combiner output is ≤ –14 dB (1.5:1).
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3.1.6.2
Establishing TX ERP and Setting Base Radio Power Output
Perform this procedure to establish the transmit (TX) Effective Radiated Power (ERP) and set the base
radio power output.

Procedure:
1 Calculate the value to program into the Configuration/Service Software (CSS) TX power out

(Watts) using the formula TX Power Out = ERP - TX Ant Gain + TX Line Loss + TX RFDS Loss.
All the values are in dB or dBm.

2 Identify the Set CSS Power Out to value and enter this value in the CSS.

3 To write this value to the base radio, open CSS, select Configuration from the system tree, and
click the Hardware Configuration tab. Enter the value into the Tx Power Output (Watts) field.
Press CTRL+W.

4 Calculate a Set CSS Power to value. This value sets the transmitter output to no greater than
the desired ERP. If the base radio rated power results in an ERP of less than the desired ERP,
the Set CSS Power to value equals the rated power. It is possible to set the CSS TX power
output Watts to 10% higher than rated power, however, the spreadsheet calculates only a value
up to the base radio rated power.

5 Record the actual CSS TX power out value.

6 If you did not change the CSS TX power from the rated value previously used, transfer the
wattmeter readings previously obtained.

7 From CSS, select Service → Test and Measurement Screen.

8 From the Test and Measurement screen, key the base radio (V.52). Click Start Pattern
Transmission.

9 Record the wattmeter reading.

10 If using a wattmeter other than a Rohde&Schwarz, perform the following actions. If using a
Rohde&Schwarz, proceed to step 11.

a De-key the base radio and verify that the wattmeter reading drops to zero.

b Install the 5 W or 10 W wattmeter element to read reflected power.

CAUTION: Orient the element correctly to read reverse (reflected) power, otherwise
damage may occur.

c Key the base radio (V.52). Click Start Pattern Transmission.

11 Record the reverse power reading.

12 De-Key the base radio. Click Stop Pattern Transmission and verify that the wattmeter drops to
zero.

13 If using a wattmeter other than a Rohde&Schwarz, re-install the 50W element in the wattmeter
(orient to read forward power).

14 Verify that the actual ERP ≤ licensed ERP.

The actual combiner power and the actual reflected power measurements taken become the
baseline values for future PM checks of the site.

15 Perform the following actions to set up CSS metering.

a In the CSS menu, select Service → Metering Screen. Select the Transmitter tab. Click
Test Transmitter.

b Record the CSS Base Radio Forward Power, Base Radio Reflected Power, and Base Radio
Voltage Standing Wave Ratio (VSWR) values. (these values become the baseline for future
routine checks).
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c Verify that the CSS Base Radio Forward Power (Watts) and CSS TX Power Out values
agree ±7% and that the CSS Base Radio VSWR ≤1.5:1.

d Terminate the CSS session by pressing CTRL+K.

16 Repeat all the above RFDS test activities on the remaining base radios at the site, then proceed
with the next step.

17 Remove the (inline) wattmeter, restore the TX antenna jumper cable to the cabinet TX antenna
port, and power down the wattmeter.

Ensure that you establish the appropriate site ERP values. It is a regulatory (FCC in the USA)
requirement.

If the site uses a Tower Top Amplifier (TTA), see Testing RX with a Tower Top Amplifier (TTA)
on page 64. If the site does not use a TTA, see Testing RX without a Tower Top Amplifier
(TTA) on page 68.

3.1.6.3
Testing RX with a Tower Top Amplifier (TTA)
Perform this procedure to test the receive (RX) capability on systems with a Tower Top Amplifier
(TTA).

Prerequisites: Test the TTA before installation on the tower. The following tests do not verify that the
TTA is performing to specifications. The values documented in the procedure are only relative baseline
values that can be used to set the baseline or troubleshoot the system in the future.

Procedure:
1 Configure RX with a TTA test setup as shown in the figure.

Figure 20: GTR 8000 Expandable Site Subsystem RX RFDS with TTA Test Setup
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2 Perform the following actions to establish the TTA configuration.

NOTICE:
The following guidelines result in RX operation acceptable in many situations. However,
the best performance is achieved if an RF engineer analyzes the site-specific conditions
and provides the Control Monitoring Unit (CMU) and RMU attenuation values.

The RX Total Line Loss + CMU attenuation should be a minimum of 11 dB. For 700/800
MHz systems, this value sets a nominal reserve gain of 10 dB for the TTA.

Minimum CMU attenuation = 11 – RX total line loss. Do not use a CMU attenuation value
lower than this value. The value can be set higher if specific site conditions warrant it.

a Calculate the CMU attenuator values.

b Record the actual Gain and Test Port Coupling Loss values if actual test data is available,
otherwise review default values and change them to match your TTA specification.

c Record the actual Gain and Test Port Coupling Loss values if actual test data is available,
otherwise review default values and change them to match your TTA specification.

d Record the TTA Test Port Cable Loss.

e Record the Total Line Losses dB and the Antenna Gain dB values.

f Calculate a CMU Attenuator Value.

g Program the CMU attenuator to this value or other desired value. Perform this programming
once for each TTA. Use the instructions provided with the CMU to program it. Do not leave
the CMU attenuator value at 0 or a value less than calculated above. Additional gain in the
CMU does not provide increased performance.

h Record the value set into the CMU in the actual CMU Atten setting field of the Tower Top
Amplifier Data section.

3 Perform the following actions to set the Remote Multicoupler (RMC) configuration.

Table 15: GTR 8000 Expandable Site Subsystem Attenuator Values

If RMC attenuation information is not available from an RF engineer, use the default settings as
shown in this table.

Band TTA Cabinet Site RMC Cabinet
RMC

UHF Yes Single N/A 7 dB

UHF Yes Multiple 8 dB 13 dB

700/800 Yes Single N/A 7 dB

700/800 Yes Multiple 8 dB 13 dB

a Identify and set the RMC attenuator values.

b Set the site RMC (if present) and the cabinet RMC dip switches to match the desired
attenuation values.

c Ensure the Configuration/Service Software (CSS) values match the hardware configuration
and RMC attenuation values are set up for the hardware in the CSS.

d Verify that the CSS GTR 8000 RMC configuration matches the actual installation. If a site
RMC is installed, set the Site RMC Configuration in the CSS as Installed, and set the CSS
Site RMC Attenuation to the same value as the actual dip switches.
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e Set the CSS Cabinet RMC Attenuation value the same as its actual dip switches. To save
the changes to the base radio, select File → Write Configuration To Device from the menu.
Click OK on the Confirmation window.

f Record the CSS Site RMC Attenuation value.

g Record the CSS Cabinet RMC Attenuation, and CSS System Gain (dB) values.

CAUTION: The Receive path attenuators must be configured before performing the
following portion of the procedure. The RX path must be complete to the RX antenna
on the tower.

4 Perform the following actions to perform the base radio tests with TTA.

a Connect to the base radio and read the configuration (codeplug). Alternatively press CTRL+R.

b From CSS, select Service → Test and Measurement Screen.

c When the Test and Measurement screen appears, if base radio is not in Service Mode,
click Change to Service Mode.

d From the confirmation dialog box, click OK.

The base radio begins a reset sequence to change modes, which take a few minutes.

e After the base radio resets, re-open the Test and Measurement screen.

f Click the ASTRO BER RSSI Report tab. Under the Settings area, set the Pattern Type as
P25 and establish the Sampling Period as 1 second.

g Configure the analyzer to generate an STD1011 pattern.

h Set the Analyzer Generate Frequency equal to the base radio RX frequency.

i Connect the Analyzer Gen port to the TTA Test Port using a TNC-m to BNC-m test cable
with known loss.

j Configure the TTA so that the Antenna port is terminated in a 50 Ohm load.

5 Perform the following actions to establish an RX Noise Level TTA Terminated value.

a Turn off the analyzer generator.

b Click Start RSSI Measurement to start the Received Signal Strength Indication (RSSI)
measurement test.

c Record the CSS RSSI value.

This value is relative and is documented to baseline the performance.

6 Perform the following actions to establish an RX RSSI TTA test port reference level.

a Turn on the analyzer generator

b Establish an analyzer generate RF level that produces a CSS RSSI level of -90.0 dBm.

c Record the analyzer generate RF level and calculate the actual test port ref level.

This value is relative and is documented to baseline the performance.

d Click Stop RSSI Measurement to stop the RSSI measurement test.

7 Perform the following actions to establish an Rx Sensitivity TTA Test Port Terminated value.

a Start Bit Error Rate (BER) measurement. In the CSS Test and Measurement screen, select
the ASTRO BER RSSI Report tab. Click Start BER Measurement.

b Adjust the Analyzer Generate RF Level for a 5% ± 0.25% BER.

c Record the Analyzer Generate RF Level.
d Click Stop BER Measurement to stop the BER measurement.

e Click Start RSSI Measurement to start RSSI measurement.
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f Record the CSS RSSI (dBm) value.

g Click Stop RSSI Measurement to stop RSSI measurement.

h Calculate the Actual Sensitivity using Sensitivity Terminated – Test Cable Loss - TTA Test
Port Cable Loss - TTA Test Port Coupling Loss. This value is relative and is documented to
baseline the performance.

8 Perform the following actions to establish an RX desense TTA without transmitters keyed.

The degradation specification is < 2 dB @ 700/800 MHz, < 6 dB @ 450 MHz, or < 10 dB @ 150
MHz. This test and the RX Desense TTA with transmitters keyed test cannot be performed
accurately if the channel is in use within the site coverage area (for example, legacy system
waiting for cut over).

a Configure the TTA so that the antenna port is connected to the antenna (normal operation).

b Start BER measurement. In the CSS Test and Measurement screen, select the ASTRO
BER RSSI Report tab. Click Start BER Measurement.

c If needed, readjust the Analyzer Generate RF Level for 5% ± 0.25% BER.

d Calculate and record the Analyzer Generate RF Level.
e Click Stop BER Measurement.

NOTICE:
The difference between this level and the level recorded in the RX sensitivity step 7 is the
site desense (degradation). Also, if the CSS BER reading is not stable, the reading
indicates external interference or variable noise floor. Make a note on the test result
sheet that Channel <X> BER went to <Y>% while performing this test.

Calculate the Degradation no TX value. The degradation should be less than specified in
the proceeding measurement. If the degradation is higher than recommended, consult
with the RF Engineer to determine what impact degradation could have on talk-in
coverage.

For sites with a TTA, the result from this test becomes the benchmark for future PM
checks.

9 Perform the following actions to establish an RX desense TTA with transmitters keyed (required
only for VHF sites).

For the degradation specification, see RX desense TTA without transmitters keyed.

NOTICE: This test cannot be performed if the channel under test or any of the channels
being keyed up are in use with an operating system in the same coverage area.

a Key-up all transmitters at the site. Connect to the base radio and read the configuration
(codeplug), alternatively press CTRL+R.

b From CSS, select Service → Test and Measurement Screen
c When the Test and Measurement screen appears, if base radio is not in Service Mode, click

Change to Service Mode.

d From the confirmation dialog box, click OK.

The base radio begins a reset sequence to change modes, which take a few minutes.

e After the base radio resets, re-open the Test and Measurement screen.

f Select the ASTRO BER RSSI Report tab. Click Start BER Measurement.
g If needed, readjust the Analyzer Generate RF Level for 5% ± 0.25% BER.

h Record the Analyzer Generate RF Level.
i De-key transmitters at the site.
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j Click Stop BER Measurement to stop the BER Measurement.

k Calculate the Degradation with TX value. The degradation should be less than specified . If
the degradation is higher than recommended, consult with the system engineer to determine
what impact degradation could have on talk-in coverage.

10 Perform the following actions to establish an RX Noise Level TTA to Antenna value.

a Turn off the analyzer generator.

b Click Start RSSI Measurement to start the RSSI measurement.

c Record the CSS RSSI Value.

d Click Stop RSSI Measurement to stop the RSSI measurement.

This measurement is a relative value and is documented to baseline the performance.

11 Perform the following actions to establish an Effective Receiver Sensitivity value.

a Calculate the Effective Receiver Sensitivity as the maximum of Rx Desense no Tx OR Rx
Desense with Tx – Test Cable Loss - TTA Test Port Cable Loss - TTA Test Port Coupling
Loss. Ensure that this actual value is appropriate so that there are no impacts to the system
talk-in coverage.

b Terminate the CSS session by pressing CTRL+K.

12 Perform this procedure for all the remaining channels, then proceed to step 14.

13 If Rx B is used as a backup and the site is not TDMA:

a Disconnect the test cable from the generator to Rx A at the base radio and connect it to Rx
B.

b Increase the generator level to -47 dBm.

c Wait for Branch A to fail.

• This can take up to two (2) minutes.

• CSS Channel tab Time to Failure (sec) field controls the time to fail.

d Repeat step 3 through step 11 of this procedure.

14 When all channels are complete, disconnect the test cable to the TTA test port, terminate the
TTA test port with a 50 Ohm termination.

15 Proceed to base radio final configuration. See Setting the Final Base Radio Configuration on
page 71.

3.1.6.4
Testing RX without a Tower Top Amplifier (TTA)
Perform this procedure to test the receive (RX) capability on systems without a Tower Top Amplifier
(TTA).

Procedure:
1 Configure the RX without a TTA test setup as shown in this figure.
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Figure 21: GTR 8000 Expandable Site Subsystem RX RFDS without TTA Test Setup

2 Perform the following actions to establish a Remote Multicoupler (RMC) configuration.

a Identify and set the RMC Attenuator values.

Table 16: GTR 8000 Expandable Site Subsystem Attenuator Values

If RMC Attenuation information is not available from an RF engineer, use the default
attenuator values in this table.

Band TTA Cabinet Site RMC Cabinet
RMC

UHF No Single N/A 1 dB

UHF No Multiple 4 dB 15 dB

700/800 No Single N/A 0 dB

700/800 No Multiple 1 dB 10 dB

b Ensure the Configuration/Service Software (CSS) values match the hardware configuration
and RMC Attenuator values are set up for the hardware in the CSS.

Verify that the CSS GTR 8000 RMC configuration matches the actual installation.

c If a site RMC is installed, set the Site RMC Configuration in the CSS as Installed, and set
the CSS Site RMC Attenuation to the same value as the actual dip switches.

d To save and write the changes to the base radio, alternatively press CTRL+W, and click OK in
the confirmation window.

e Record the CSS Site RMC Attenuation.

f Record the CSS Cabinet RMC Attenuation, and CSS System Gain (dB) value.
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CAUTION: The RX path attenuators must be configured before performing the
following portion of the procedure. The RX path must be complete to the RX antenna
on the tower.

g Insert a directional coupler (IsoTee may be used but a coupler is preferred) at the top of the
cabinet on the Rx Input connector. Terminate the open end (towards antenna) with a 50 Ohm
termination.

h Connect the Analyzer Gen port to the coupler (or IsoTee) port pointing towards the base
radio receivers using a cable with known loss.

3 Perform the following actions to perform base radio tests without TTA.

a Connect to the base radio and read the configuration (codeplug) by pressing CTRL+R.

b Verify the base radio (Station) is in Service Mode.

c In the CSS Test and Measurement screen, select the ASTRO BER RSSI Report tab.
Under the Settings area, set the Pattern Type as P25 and the Sampling Period as 1
second.

d Configure the Analyzer to generate an STD1011 pattern.

e Set the Analyzer Generate Frequency equal to the base radio RX frequency.

4 Perform the following actions to establish an Rx Sensitivity Coupler Terminated value.

If this test fails and the Base Radio Sensitivity Direct is passed, you most likely have incorrect
data for your test cable or coupler loss. To perform this test, you must have an accurate value
for the coupler loss factor.

a In the CSS Test and Measurement screen, select the ASTRO BER RSSI Report tab. Click
Start BER Measurement.

b Adjust the Analyzer Generate RF Level for a 5% ± 0.25% Bit Error Rate (BER).

c Record the Analyzer Generate RF Level and calculate the Calculated Actual Sensitivity
as Sensitivity Terminated – Test Cable Loss – Directional Coupler Loss Factor.

d Verify that the Calculated Actual Sensitivity is ≤ RX Sensitivity Direct Specification + 1 dB.

5 Perform the following actions to test an RX Desense Coupler without transmitters keyed.

The degradation specification is < 2 dB @ 700/800 MHz, < 6 dB @ 450 MHz, or < 10 dB @ 150
MHz.

This test and the RX Desense Coupler with transmitters keyed test cannot be performed
accurately if the channel is in use within the coverage area of the site (legacy system for
example, waiting for cutover).

a Disconnect from the coupler and connect the RX antenna jumper to the coupler.

b Readjust the Analyzer RF LEVEL if needed for 5% ± 0.25% BER.

c Record the Analyzer RF LEVEL.

The difference between this level and the level recorded in the RX Sensitivity step is the site
desense (degradation). If the CSS BER reading is not stable, this reading indicates external
interference or variable noise floor. Make a note that Channel <X> BER went to <Y>% while
performing this test.

d Calculate the Degradation no TX value. The degradation should be less than specified in the
proceeding measurement. If the degradation is higher than recommended, determine what
impact this degradation could have on talk-in coverage. For sites without a TTA, the result
from this test becomes the benchmark for future PM checks.

6 Perform the following actions to test an RX Desense Coupler with transmitters keyed.
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This test cannot be performed if the channel under test or any of the channels being keyed up
are in use with an operating system in the same coverage area.

a Key up transmitters at the site.

b Readjust the Analyzer RF LEVEL if needed for 5% ± 0.25% BER.

c Record the Analyzer RF LEVEL.

d Dekey all base radios.

e In the CSS, click Stop BER Measurement.
f Calculate the Degradation with TX value. The degradation should be less than specified

above. If the degradation is higher than recommended, consult with the system engineer to
determine what impact this degradation could have on talk-in coverage.

7 Perform the following actions to establish an Rx Noise Level with Antenna value.

a Turn off the Analyzer Generator.

b In the CSS, click Start RSSI Measurement.
c Record the CSS Received Signal Strength Indication (RSSI) (dBm) value.

d In the CSS, click Stop RSSI Measurement.
8 Perform the following actions to test Effective Receiver Sensitivity.

a Calculate the Effective Receiver Sensitivity as the maximum of Rx Desense no Tx or Rx
Desense with Tx – Test Cable Loss – Directional Coupler Loss Factor + Rx Total Line
Losses. Ensure that this actual value is appropriate to prevent impact on the system talk-in
coverage.

b Terminate the CSS session by pressing CTRL+K.

9 Perform this procedure for all the remaining channels, then proceed to step 11.

10 If Rx B is used as a backup and the site is not TDMA:

a Disconnect the test cable from the generator to Rx A at the base radio and connect it to Rx
B.

b Increase the generator level to -47 dBm.

c Wait for Branch A to fail.

• This can take up to two (2) minutes.

• CSS Channel tab Time to Failure (sec) field controls the time to fail.

d Repeat step 2 through step 8 of this procedure.

11 When all channels are complete, disconnect the test cables and restore the connection from the
RX antenna jumper to the cabinet RX input.

12 Proceed to final base radio configuration. See Setting the Final Base Radio Configuration on
page 71.

3.1.7
Setting the Final Base Radio Configuration
Perform the following procedure to set your base radio to its final configuration.

Procedure:
1 Perform the following actions to clear the status logs:

a Connect to the base radio and read the configuration (codeplug) by pressing CTRL+R.
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b From the Configuration/Service Software (CSS) menu, select Service → Status Report
Screen. Click Clear Report.

c Change the Report Type to Engineering. Click Clear Report.
2 Validate Launch Time Delay Offset.

For simulcast sites ONLY, in the CSS, click the ASTRO Simulcast tab. If a launch time delay is
required at this site, enter the value in microseconds into the Launch Time Offset. This value is
saved when the base radio is placed back into Normal Mode. Do not enter any value unless an
RF engineer has determined the correct value. This field is normally left blank.

3 Record the CSS Launch Time value.

4 Make an Illegal Carrier Determination.

RF Threshold Value default is normally sufficient unless you have a high noise floor or low-level
interference. Add +13.5 dB to the base radio RX noise level. If this level is higher than the
existing default number, use the new value.

5 Edit the RF Threshold Value (dBm) field and write the new configuration by pressing CTRL+W.

6 Perform the following actions to verify that base radio is in Normal mode.

a From CSS, select Service → Mode Screen
b From the Mode screen, verify that the base radio mode is set to Normal.
c If the base radio is in Service Mode, click Change to Normal Mode.

7 Perform the following actions to check base radio Hardware Status.

a From the CSSe menu, select Service → Status Panel. Select the Hardware Status tab,
and ensure that no failures are indicated. Select the Operational Status tab and ensure that
the base radio indicates that it is in Normal mode and that both the Transmitter and Receiver
are Enabled.

b Perform substep a. for all base radios and then continue with the next step.

8 Perform the following Site and Analyzer Final actions.

a Configure the Analyzer for Internal Reference.

b Disconnect the cable from the Analyzer Reference I/O to the TRAK.

9 Remove the FDM module.

If a temporary FDM module was installed in the TRAK at the beginning of this procedure,
remove the module from the TRAK.

10 Restore the site link connection.

Table 17: GTR 8000 Expandable Site Subsystem Attenuator Values

These attenuator settings are the default configuration:

Band TTA Cabinet Site RMC Cabinet
RMC

UHF No Single N/A 1 dB

UHF Yes Single N/A 7 dB

UHF No Multiple 4 dB 15 dB

UHF Yes Multiple 8 dB 13 dB

7/800 No Single N/A 0 dB

7/800 Yes Single N/A 7 dB
Table continued…

MN004282A01-A
Chapter 3:  Test and Verification

72  Send Feedback

http://docsurvey.motorolasolutions.com


Band TTA Cabinet Site RMC Cabinet
RMC

7/800 No Multiple 1 dB 10 dB

7/800 Yes Multiple 8 dB 13 dB

Figure 22: Attenuation Value (13 dB)
This figure shows an example of Attenuation value set to 13 dB.

Figure 23: Attenuation Value (8 dB)
This figure shows an example of Attenuation value set to 8 dB.
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Appendix A

Site Preparation and R56 Compliance Checklist
This section provides information about obtaining and preparing all hardware, software, support, and test equipment necessary to set up,
configure, and optimize the system.

A document listing detailed parameter information for all system components is provided with your system.

A.1
Site Preparation
The following table lists the activities for preparing the site and the chapter references in the Motorola Solutions R56 Standards and Guidelines for
Communication Sites manual. This manual may be purchased by calling the North America Parts Organization at 800–422–4210 or the
international number at 302–444–9842.

Activity Description R56 Manual Reference

Review the
site plan

Prevent potential on-site and off-site interference by other local radio sys-
tems. Minimize cable lengths. Determine the location of telecom equip-
ment.

Chapter 2, “Site Design and Development”

Determine site
access and
security

Outline site access and security measures. Chapter 2, “Site Design and Development”

Review safety
considerations

Outline general, installation, and environmental safety guidelines and re-
quirements, and OSHA-related considerations.

Chapter 3, “Communications Site Building De-
sign and Installation”

Schedule in-
stallation of
telephone
service

Ensure options and functions of onsite, two-way communications for per-
sonnel safety and maintenance.

Chapter 3, “Communications Site Building De-
sign and Installation”

Review
grounding
specifications

Ensure that the site meets or exceeds the design, grounding, power, and
surge suppression requirements listed in R56 Compliance Checklist on
page 76.

Chapter 4, “External Grounding”

Chapter 5, “Internal Ground”

Chapter 6, “Power Sources”

Chapter 7, “Surge Protective Devices”
Table continued…
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Activity Description R56 Manual Reference

Schedule In-
stallation of
site power

Cover grounding, power sources, and surge protection. Chapter 4, “External Grounding”

Chapter 5, “Internal Ground”

Chapter 6, “Power Sources”

Chapter 7, “Surge Protective Devices”

A.2
R56 Compliance Checklist

Activity Description Reference

R56 Compliance The site should meet R56 standards and be audited by an ETA-
certified R56 auditor to verify compliance.

Motorola Solutions R56 Standards and Guide-
lines for Communication Sites Manual, and the
following checklist.

R56 Compliance Checklist

Customer Name: Project Name:

Project Manager: Project No.:

Inspector Name: Audit Date:

Table 18: General

1. GENERAL

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Solu-
tions

Customer

Passed Failed Passed Failed N/A Date Correc-
ted

Date Correc-
ted

R56 Manual
Reference

a. A copy of the
Project Man-
ager Compli-
ance Sheet
has been com-
pleted, certi-

Table continued…
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1. GENERAL

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Solu-
tions

Customer

Passed Failed Passed Failed N/A Date Correc-
ted

Date Correc-
ted

R56 Manual
Reference

fied, and sup-
plied for at-
tachment to
this audit.

b. Project Man-
ager Compli-
ance Sheet
shows that all
appropriate re-
quirements
have been
met.

TOTALS for
Section 1

Enter Section 1 totals here and on AUDIT SUMMARY

Table 19: Building Design and Installation

2. BUILDING DE-
SIGN AND INSTAL-
LATION

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Solu-
tions

Customer

Passed Failed Passed Failed N/A Date Correc-
ted

Date Corrected R56 Manual
Reference

a. The ceiling
height is suffi-
cient to meet
requirements
for equipment
installation.

3.6.1

b. Cable runway
system meets
the proper in-

3.10.5

Table continued…
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2. BUILDING DE-
SIGN AND INSTAL-
LATION

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Solu-
tions

Customer

Passed Failed Passed Failed N/A Date Correc-
ted

Date Corrected R56 Manual
Reference

stallation re-
quirements.

c. The floor is
sealed as re-
quired.

3.6.2

d. Transmission
line entry
ports, holes, or
openings
which pene-
trate the outer
surface of the
building have
been properly
sealed.

3.7.1

e. Adequate light-
ing require-
ments have
been met.

3.11

f. Maximum re-
quired fire sup-
pression
equipment is
properly instal-
led.

3.12

g. A first aid kit is
available and
meets require-
ments.

3.13.1

h. Required per-
sonal protec-

3.13.2

Table continued…
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2. BUILDING DE-
SIGN AND INSTAL-
LATION

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Solu-
tions

Customer

Passed Failed Passed Failed N/A Date Correc-
ted

Date Corrected R56 Manual
Reference

tive safety
items are avail-
able for servic-
ing batteries
which require
such items.

i. A telephone,
microwave
link, or cellular
phone has
been made
available.

3.14

j. Phone num-
bers of impor-
tance are pos-
ted at the site.

3.14

k. The minimum
required sig-
nage is posted
at the site.

3.15

TOTALS for
Section 2

Enter Section 2 totals here and on AUDIT SUMMARY
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Table 20: External Grounding

3. EXTERNAL
GROUNDING

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Solu-
tions

Customer

Passed Failed Passed Failed N/A Date Corrected Date Correc-
ted

R56 Manual
Reference

a. An External
Ground Bus
bar (EGB) of
suitably sized
material is
properly in-
stalled at the
transmission
line entry
point.

4.4.3

b. The EGB
grounding
electrode con-
ductor has
been properly
installed.

4.4.3

c. When a Tow-
er Ground
Bus bar
(TGB) is
used, it meets
the proper in-
stallation and
bonding re-
quirements.

4.4.3.1

d. Each trans-
mission line
outer shield is
properly bon-
ded to the
tower or TGB

4.7.9

Table continued…
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3. EXTERNAL
GROUNDING

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Solu-
tions

Customer

Passed Failed Passed Failed N/A Date Corrected Date Correc-
ted

R56 Manual
Reference

at the transi-
tion of the ver-
tical transmis-
sion line run
with a weath-
er-sealed
transmission
line grounding
kit.

e. Each trans-
mission line
outer shield is
properly bon-
ded to the
EGB with a
weather-
sealed trans-
mission line
grounding kit.

4.7.9

f. The tower is
properly bon-
ded with the
required num-
ber of ground-
ing conduc-
tors.

4.7.6, 4.9

g. Ice bridges /
cable sup-
ports have
been properly
bonded to the
EGB.

4.7.10.2

Table continued…
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3. EXTERNAL
GROUNDING

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Solu-
tions

Customer

Passed Failed Passed Failed N/A Date Corrected Date Correc-
ted

R56 Manual
Reference

h. Each ice
bridge / cable
support post
has been
properly bon-
ded to the
grounding
electrode sys-
tem.

4.7.10.2

i. Ice bridges /
cable sup-
ports have
been properly
isolated from
the tower.

4.7.10.2

j. Guy wires are
properly bon-
ded and their
grounding
conductor
maintains a
continuous
vertical drop
to the ground-
ing electrode.

4.7.6.2.1

k. Fencing has
been properly
bonded to a
ground sys-
tem as re-
quired.

4.7.10.1

Table continued…
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3. EXTERNAL
GROUNDING

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Solu-
tions

Customer

Passed Failed Passed Failed N/A Date Corrected Date Correc-
ted

R56 Manual
Reference

l. Each fence
gate is prop-
erly bonded to
its supporting
fence post as
required.

4.7.10.1

m. Gate support-
ing fence
posts are
properly bon-
ded as re-
quired.

4.7.10.1

n. Generator
and support
skids have
been properly
bonded as re-
quired.

4.7.7.1, 6.9.7

o. Items listed
are properly
bonded to the
grounding
electrode sys-
tem as re-
quired.

o.1 Metallic
entry ports

4.7.10

o.2 Cable
conduits or
raceways

4.7.10

Table continued…
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3. EXTERNAL
GROUNDING

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Solu-
tions

Customer

Passed Failed Passed Failed N/A Date Corrected Date Correc-
ted

R56 Manual
Reference

o.3 Metallic
piping (water,
gas, electrical
conduits, and
so on.)

4.7.10

o.4 Air condi-
tioner units

4.7.10

o.5 Metal sid-
ing and/or
roofing on
buildings

4.7.10

o.6 Vent cov-
ers and grates

4.7.10

o.7 Metal fuel
storage tanks
(above or be-
low ground)

4.7.10, 6.9.7

o.8 Building
skid or pier
foundations

4.7.10

o.9 Anchors
on prefabrica-
ted buildings

4.7.10

o.10 Metallic
structures for
antenna sup-
ports, light fix-
tures, and so
on

4.7.6.3, 4.7.10

Table continued…
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3. EXTERNAL
GROUNDING

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Solu-
tions

Customer

Passed Failed Passed Failed N/A Date Corrected Date Correc-
ted

R56 Manual
Reference

o.11 Satellite
dish supports

4.8

o.12 GNSS
antenna sup-
ports

4.8

o.13 Hand
and safety
rails

4.7.10

o.14 Ladders
and safety ca-
ges

4.7.10

o.15 Security
bars and win-
dow frames

4.7.10

o.16 Main
electrical
ground

4.3, 6.2.2

o.17 Main Tel-
co ground

4.3, 4.7.10

p. Approved
bonding tech-
niques have
been used for
the connec-
tion of dissimi-
lar metals.

4.5

q. Approved
methods have
been used for
conductor

4.6

Table continued…
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3. EXTERNAL
GROUNDING

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Solu-
tions

Customer

Passed Failed Passed Failed N/A Date Corrected Date Correc-
ted

R56 Manual
Reference

connection
and termina-
tion.

r. Bonding sur-
faces for lugs
and clamps
are free of
paint and cor-
rosion and a
conductive
anti-oxidant
compound
has been ap-
plied.

4.5.4, 4.6.1

s. All painted or
galvanized
bonding surfa-
ces for exo-
thermic welds
were cleaned
and painted to
inhibit rusting.

4.6

t. All grounding
conductors
have been
routed to-
wards the
EGB, TGB, or
the grounding
electrode sys-
tem and the
minimum

4.4.2.2

Table continued…
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3. EXTERNAL
GROUNDING

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Solu-
tions

Customer

Passed Failed Passed Failed N/A Date Corrected Date Correc-
ted

R56 Manual
Reference

bending radi-
us has been
observed.

u. Grounding
conductors
are routed as
straight as
possible and
protected
from physical
damage as
required.

4.4.2.3

v. Grounding
conductors
maintain the
minimum re-
quired sepa-
ration from
other cable
groups.

4.4.2.3

w. Grounding
conductors
are securely
fastened as
required.

4.4.2.3

x. Grounding
conductors
meet or ex-
ceed the con-
ductor size re-
quirements.

4.4.2.1

Table continued…
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3. EXTERNAL
GROUNDING

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Solu-
tions

Customer

Passed Failed Passed Failed N/A Date Corrected Date Correc-
ted

R56 Manual
Reference

y. Braided
grounding
conductors
are not used
anywhere in
the external
ground sys-
tem.

4.7.9

TOTALS for
Section 3

Enter Section 3 totals here and on AUDIT SUMMARY

Table 21: Internal Grounding

4. INTERNAL
GROUNDING

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Solu-
tions

Customer

Passed Failed Passed Failed N/A Date Correc-
ted

Date Correc-
ted

R56 Manual
Reference

a. A properly
sized Master
Ground Bus
(MGB) is in-
stalled as re-
quired.

5.3.1

b. The MGB
grounding
electrode
conductor
has been
properly bon-
ded and rout-

5.3.1.3

Table continued…
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4. INTERNAL
GROUNDING

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Solu-
tions

Customer

Passed Failed Passed Failed N/A Date Correc-
ted

Date Correc-
ted

R56 Manual
Reference

ed towards
the grounding
electrode sys-
tem.

c. All conductor
connections
to the MGB
follow ap-
proved con-
nection meth-
ods.

5.4.3

d. Where re-
quired a Sub-
System
Ground Bus
Bar (SSGB)
has been
properly in-
stalled.

5.3.2

e. The SSGB
has been
bonded back
to the MGB
as required.

5.3.2.3

f. All conductor
connections
to the SSGB
follow the ap-
proved con-
nection meth-
ods.

5.4.3

Table continued…
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4. INTERNAL
GROUNDING

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Solu-
tions

Customer

Passed Failed Passed Failed N/A Date Correc-
ted

Date Correc-
ted

R56 Manual
Reference

g. Where re-
quired, an In-
ternal Perim-
eter Ground
Bus (IPGB) is
properly in-
stalled.

5.3.7

h. Only ancillary
equipment is
bonded to the
IPGB.

5.3.7

i. Each ancillary
support appa-
ratus is prop-
erly bonded
to the IPGB,
MGB, or
SSGB.

5.4.1, 5.5.1.6

j Items listed
are properly
bonded to the
MGB, SSGB,
or IPGB by
the approved
connection
methods.

j.1 Piping sys-
tems

5.5.1.6, 5.5.1.7

j.2 Steel roof
trusses

5.5.1.7
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4. INTERNAL
GROUNDING

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Solu-
tions

Customer

Passed Failed Passed Failed N/A Date Correc-
ted

Date Correc-
ted

R56 Manual
Reference

j.3 Exposed
support
beams or col-
umns

5.5.1.7

j.4 Ceiling
grids

5.8.3.2

j.5 Raised
equipment
floor support
structure at
the proper in-
tervals

5.4.2, 5.8.3.2

j.6 Any ex-
posed metal-
lic building
materials
(metal siding)

5.5.1.6

k. Surge Protec-
tion Device
(SPD) metal
housings are
bonded to the
MGB, SSGB,
or IPGB as
required.

5.5.1.6

l. Separately
derived AC
electrical sys-
tems are bon-
ded to the
MGB or

5.5.1.1

Table continued…
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4. INTERNAL
GROUNDING

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Solu-
tions

Customer

Passed Failed Passed Failed N/A Date Correc-
ted

Date Correc-
ted

R56 Manual
Reference

SSGB as re-
quired.

m. Primary tele-
phone, con-
trol, and data
network cir-
cuit SPDs are
properly in-
stalled bon-
ded to the
MGB or
SSGB as re-
quired.

5.5.1.8.2

n. RF transmis-
sion line
SPDs are
bonded to the
MGB or a
separate
equipment
area SSGB
as required.

5.5.1.8.1

o. Cable run-
ways are
bonded to the
MGB or
SSGB as re-
quired.

5.5.1.5

p. Each cable
runway sec-
tion is bonded
to the adjoin-

5.5.1.5

Table continued…
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4. INTERNAL
GROUNDING

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Solu-
tions

Customer

Passed Failed Passed Failed N/A Date Correc-
ted

Date Correc-
ted

R56 Manual
Reference

ing section as
required.

q. Ground bus
conductors
and their ex-
tensions are
sized as re-
quired.

5.3.5, 5.3.6

r. All ground
bus conduc-
tors, ground
bus exten-
sions, and
equipment
grounding
conductors
are routed to-
wards the
MGB or
SSGB as re-
quired.

5.3.4

s. Bonding con-
nections to a
ground bus or
its extensions
have been
properly insu-
lated as re-
quired.

5.3.4

t. Cabinets
have been
properly bon-

5.5.1.4

Table continued…
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4. INTERNAL
GROUNDING

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Solu-
tions

Customer

Passed Failed Passed Failed N/A Date Correc-
ted

Date Correc-
ted

R56 Manual
Reference

ded back to
the MGB,
SSGB, or
ground bus
by approved
methods.

u. Racks have
been properly
bonded back
to the MGB,
SSGB, or
ground bus
by approved
methods.

5.5.1.4

v. Any RGB lo-
cated in a
cabinet or
rack is prop-
erly bonded
back to the
MGB, SSGB,
or ground bus
as required.

5.3.3

w. Individual
system com-
ponent chas-
sis equipment
is properly
bonded as re-
quired.

5.5.1.3

x. Secondary
telephone,

5.5.1.8.3,
5.8.3.1

Table continued…
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4. INTERNAL
GROUNDING

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Solu-
tions

Customer

Passed Failed Passed Failed N/A Date Correc-
ted

Date Correc-
ted

R56 Manual
Reference

control, and
data network
circuit SPDs
are properly
installed and
bonded back
to MGB or
SSGB as re-
quired.

y. All required
control center
and dispatch
equipment is
properly bon-
ded back to
the MGB,
SSGB, or
ground bus
conductor as
required.

5.8.3

TOTALS for
Section 4

Enter Section 4 totals here and on AUDIT SUMMARY
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Table 22: Power Sources

5. POWER SOUR-
CES

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Solu-
tions

Customer

Passed Failed Passed Failed N/A Date Correc-
ted

Date Correc-
ted

R56 Manual
Reference

a. Circuit break-
ers are la-
beled to iden-
tify the recep-
tacle outlet
they are pro-
tecting.

6.2.6

b. Proper clear-
ance require-
ments are be-
ing observed
for power pan-
els.

6.2.4

c. Outlet boxes
are perma-
nently marked
to identify their
assigned cir-
cuit breakers
and panels.

6.2.10

d. Power recep-
tacle outlets
are mounted
securely to the
supporting
structure.

6.2.11

e. Adequate
service recep-
tacle outlets
are provided

6.2

Table continued…
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5. POWER SOUR-
CES

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Solu-
tions

Customer

Passed Failed Passed Failed N/A Date Correc-
ted

Date Correc-
ted

R56 Manual
Reference

for the techni-
cian.

f. Each critical
piece of
equipment
has a dedica-
ted branch cir-
cuit and dedi-
cated simplex
receptacle.

6.2.10

g. Power recep-
tacles are in-
stalled by the
equipment
load as re-
quired.

6.2.10

h. Extension
cords, includ-
ing temporary
outlet strips,
are not used
in the final in-
stallation.

6.2.9

i. Exterior re-
ceptacle out-
lets and cir-
cuits are GFCI
protected as
required.

6.2.5.1

j. AC power re-
ceptacle out-

6.2.11

Table continued…
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5. POWER SOUR-
CES

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Solu-
tions

Customer

Passed Failed Passed Failed N/A Date Correc-
ted

Date Correc-
ted

R56 Manual
Reference

lets and strips
are of the
proper type
and securely
mounted off
the floor.

k. Appropriate
clearance is
being ob-
served for the
safe servicing
of UPS and
battery banks.

6.5.1

l. The neutral –
ground bond-
ing conductor
has been
properly in-
stalled in the
main service
disconnect as
required.

6.2.2

m. Equipment
grounding
conductors
have been in-
stalled as re-
quired.

6.2.7

n. Solar panels
have been lo-
cated away
from objects

6.6.2

Table continued…
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5. POWER SOUR-
CES

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Solu-
tions

Customer

Passed Failed Passed Failed N/A Date Correc-
ted

Date Correc-
ted

R56 Manual
Reference

that could
damage or
block sunlight
to the panel.

o. Proper mount-
ing practices
are being ob-
served for so-
lar panels or
wind genera-
tors.

6.6.2

p. Battery racks
are bolted to
the floor or
wall.

6.7.9

q. Battery con-
ductors are
enclosed in
PVC, metallic
conduit, or
raceways.

6.7.9

r. A battery dis-
connect and
suitable circuit
protection de-
vice has been
installed as re-
quired.

6.7.9

s. When a stand-
by power gen-
erator has

6.8

Table continued…
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5. POWER SOUR-
CES

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Solu-
tions

Customer

Passed Failed Passed Failed N/A Date Correc-
ted

Date Correc-
ted

R56 Manual
Reference

been installed,
it meets the
proper instal-
lation require-
ments.

t. Standby gen-
erators are lo-
cated in areas
only accessi-
ble by author-
ized person-
nel.

6.9.1

u. Standby gen-
erators have
an adequate
area provided
for servicing.

6.9.1

v. Fuel storage
tanks for
standby gen-
erators are lo-
cated in a se-
cured area.

6.9.2

w. A dedicated
electrical cir-
cuit has been
provided at
the generator.

6.9.4

x. A transfer
switch of the
proper ampac-

6.9.3

Table continued…
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5. POWER SOUR-
CES

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Solu-
tions

Customer

Passed Failed Passed Failed N/A Date Correc-
ted

Date Correc-
ted

R56 Manual
Reference

ity rating has
been installed
to switch be-
tween com-
mercial power
and standby
generator
power.

y. A main serv-
ice disconnect
has been in-
stalled as re-
quired.

6.2.1, 6.2.5

z. Electrical pan-
el board am-
pacity ratings
are properly
coordinated.

6.2

TOTALS for
Section 5

Enter Section 5 totals here and on AUDIT SUMMARY

Table 23: Transient Voltage Surge Suppression

6. TRANSIENT
VOLTAGE SURGE
SUPPRESSION

Site Name:

Motorola Solultions
Responsibility

Customer Responsi-
bility

Motorola Sol-
utions

Customer

Passed Failed Passed Failed N/A Date Correc-
ted

Date Correc-
ted

R56 Manual
Reference

a. A Type 1
SAD/MOV
Surge Protec-

7.4.1

Table continued…

MN004282A01-A
Appendix A:  Site Preparation and R56 Compliance Checklist

Send Feedback   101

http://docsurvey.motorolasolutions.com


6. TRANSIENT
VOLTAGE SURGE
SUPPRESSION

Site Name:

Motorola Solultions
Responsibility

Customer Responsi-
bility

Motorola Sol-
utions

Customer

Passed Failed Passed Failed N/A Date Correc-
ted

Date Correc-
ted

R56 Manual
Reference

tion Device
(SPD) is instal-
led as re-
quired.

b. A Type 2 MOV
SPD is instal-
led as re-
quired.

7.4.1

c. Primary SPDs
for telephone
circuits are in-
stalled as re-
quired.

7.5

d. Secondary
SPDs for tele-
phone circuits
are installed as
required.

7.5

e. Primary SPDs
for control cir-
cuits are instal-
led as re-
quired.

7.5

f. Secondary
SPDs for con-
trol circuits in-
stalled as re-
quired.

7.5

g. Primary SPDs
for data net-
work circuits

7.5

Table continued…
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6. TRANSIENT
VOLTAGE SURGE
SUPPRESSION

Site Name:

Motorola Solultions
Responsibility

Customer Responsi-
bility

Motorola Sol-
utions

Customer

Passed Failed Passed Failed N/A Date Correc-
ted

Date Correc-
ted

R56 Manual
Reference

are installed as
required.

h. Secondary
SPDs for data
network cir-
cuits are instal-
led as re-
quired.

7.5

i. All RF trans-
mission lines,
including un-
used spares,
have coaxial
RF SPDs prop-
erly installed
as required.

7.6

j. Where a tower
top amplifier
has been in-
stalled, the
sample port
and its control
cables have
SPDs installed
as required.

7.6

k. Tower lighting
system AC
power and da-
ta/alarm cir-
cuits have
SPDs properly
installed as re-
quired.

7.8

Table continued…
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6. TRANSIENT
VOLTAGE SURGE
SUPPRESSION

Site Name:

Motorola Solultions
Responsibility

Customer Responsi-
bility

Motorola Sol-
utions

Customer

Passed Failed Passed Failed N/A Date Correc-
ted

Date Correc-
ted

R56 Manual
Reference

TOTALS for
Section 6

Enter Section 6 totals here and on AUDIT SUMMARY

Table 24: Equipment Installation

7. EQUIPMENT IN-
STALLATION

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Sol-
utions

Customer

Passed Failed Passed Failed N/A Date Correc-
ted

Date Correc-
ted

R56 Manual
Reference

a. Equipment
spacing and
aisle widths
conform to
guidelines.

9.3

b. Equipment is
level and
plumb.

9.5

c. Equipment is
square with
surrounding
equipment and
walls.

9.5

d. Where appli-
cable, seismic
installation
practices have
been ob-
served.

9.4
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7. EQUIPMENT IN-
STALLATION

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Sol-
utions

Customer

Passed Failed Passed Failed N/A Date Correc-
ted

Date Correc-
ted

R56 Manual
Reference

e. Cabinets and
racks are se-
cured as re-
quired.

9.6

f. Cables and
cable groups
of different
function main-
tain a mini-
mum 5 cm (2
in.) separation
as required.
Cables and
cable groups
of different
function main-
tain a mini-
mum 5 cm (2
in.) separation
as required.

9.9.1.5

g. RF cables
meet or ex-
ceed minimum
bending radius
requirements.

9.9.1.4, 9.9.8

h. Plenum-rated
cables are in-
stalled as re-
quired.

9.9.2

i. Proper cable
lengths used.

9.9.1.2

Table continued…
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7. EQUIPMENT IN-
STALLATION

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Sol-
utions

Customer

Passed Failed Passed Failed N/A Date Correc-
ted

Date Correc-
ted

R56 Manual
Reference

j. Cables are
properly se-
cured at the
required inter-
vals.

9.9

k. AC power con-
ductors instal-
led on cable
runway sys-
tems meet in-
stallation re-
quirements.

3.10.4, 9.9.4

l. Cables are
properly identi-
fied with a
standard, dou-
ble-ended sys-
tem.

9.9.12

m. Distribution
frame wiring
conforms to
the proper
punch-down or
wire-wrap
techniques.

9.9.11

n. CAT-5 cables
maintain the
proper separa-
tion from AC
power cables.

9.9.6.4

Table continued…
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7. EQUIPMENT IN-
STALLATION

Site Name:

Motorola Solutions
Responsibility

Customer Responsi-
bility

Motorola Sol-
utions

Customer

Passed Failed Passed Failed N/A Date Correc-
ted

Date Correc-
ted

R56 Manual
Reference

o. CAT-5 cables
do not have
any sharp
bends.

9.9.6.5

p. CAT-5 cables
meet all other
installation re-
quirements.

9.9.6

q. Cables instal-
led below
raised flooring
systems are
properly instal-
led.

3.10.2, 9.9

r. Cables instal-
led above sus-
pended ceil-
ings are prop-
erly installed.

9.9.3.3

s. Electrostatic
discharge
practices are
observed as
required.

9.10

TOTALS for
Section 7

Enter Section 7 totals here and on AUDIT SUMMARY

Table 25: Audit Summary

AUDIT SUMMARY

Customer Name: Project Name:
Table continued…
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AUDIT SUMMARY

Project Manager: Project No.:

Inspector Name: Audit Date:

Site Name:

Motorola Solutions Customer

Number of
Passed

Number of
Failed

Number of Passed Number of
Failed

Total N/A

Section Totals

1. General

2. Building Design and Instal-
lation

3. External Grounding

4. Internal Grounding

5. Power Sources

6. Transient Voltage surge
Suppression

7. Equipment Installation

AUDIT TOTALS
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Appendix B

Service Laptop and Software Setup
for ASTRO 25 Express
If you are required to use a Service Laptop for system configuration, maintenance, or troubleshooting,
download and set up the applicable software applications.

B.1
Service Laptop Overview for ASTRO 25 Express
If you require a Service Laptop for system configuration, maintenance, or troubleshooting, install the
following software applications.

• Configuration/Service Software (CSS) to configure and troubleshoot the GTR 8000 Base Radios
and GCP 8000 Site Controllers to back up copies of configuration information. See Configuration/
Service Software for ASTRO 25 Express on page 110.

• Software Download Manager (SWDL) to download firmware to the base radios and site controller.
See Software Download Manager on page 112.

• Customer Programming Software (CPS) to program subscriber radios. See Customer Programming
Software on page 113.

Laptop hardware and OS requirements depend on which software you intend to use. See requirements
for specific software in the following section. Depending on your system configuration, install the
following software on the Service Laptop. Follow the instructions on the installation media for each
software application.

B.1.1
Service Laptop Requirements for CPS for ASTRO 25 Express
For Customer Programming Software (CPS) Service Laptop hardware and OS requirements, see
CPS_readme.txt file on the CPS installation media or in the program installation directory.

B.1.2
Service Laptop Requirements for CSS for ASTRO 25 Express
The Configuration/Service Software (CSS) is used for GCP 8000 Site Controllers and GTR 8000 Base
Radios.

Operating Systems:

• Windows 7 32 bit and 64 bit

• Windows 10 32-bit and 64-bit

Hardware Requirements:

• 1 GHz or higher Pentium grade processor

• 1 GB RAM recommended for Windows 7 32-bit

• 2 GB RAM recommended for Windows 7 64-bit

• 1 GB RAM recommended for Windows 10 32-bit

• 2 GB RAM recommended for Windows 10 64-bit
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• 300 MB minimum free space for CSS Typical Installation (including Help Text and Software
Download Manager) or 100 MB minimum free space for a Compact Installation

• 300 MB minimum free space for RSS Typical Installation (including Help Text and Software
Download Manager) or 100 MB minimum free space (for a Compact Installation)

Peripherals:

• Serial port or a USB with a USB to serial converter as a connection device (not certified from
Motorola Solutions)

• Microsoft Windows supported mouse or trackball

• Microsoft Windows supported 10 Base T Ethernet port for product communication

• Microsoft Windows supported printer port for report printing

• Software installation media

B.1.3
Service Laptop Requirements for Other Software for ASTRO 25
Express
Load the Service Laptop with the following software:

• Remote Desktop Connection or a similar utility

• PuTTY (for Serial, Secure SHell (SSH) and Telnet connections) or a similar utility

• Microsoft Internet Explorer (latest) or Firefox (latest) for Configuration/Service Software (CSS)

B.2
Configuration/Service Software for ASTRO 25 Express
The Configuration/Service Software (CSS) is a Windows-based application installed on a laptop or
desktop computer used to configure, report status, and service tasks for infrastructure devices in the
system. The CSS application allows a service technician to:

• Configure operating parameters for infrastructure devices.

• Retrieve status and operational information from a device.

• Perform alignment procedures for the infrastructure devices that can use the CSS.

• Set the IP address for specified devices, which requires a local serial connection.

• Perform most device configuration and servicing tasks either through a serial connection to the
device or over the LAN.

Use the CSS to configure and service the parameters for the site devices in your system. The devices
configured using the CSS are:

• Base radio

• Site controller

The CSS is used to configure the parameters on the GTR 8000 Base Radios and on the GCP 8000
Site Controller. CSS can access each device over the local LAN, or individually through the Ethernet
service port. The DB-9 serial port connection is used to set the IP address for the GTR 8000 Base
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Radio and on the GCP 8000 Site Controller. CSS also can be used to view status information, equalize
batteries, and check internal logs of the equipment at the site.

Table 26: Installing and Upgrading the CSS

Activity Description Reference

Install CSS Install the CSS on the service laptop. The
Software Download Manager (SWDL) appli-
cation is included on the same software in-
stallation media.
After installation, two icons appear on the
desktop:

Launches the CSS application

 Launches the SWDL application

CSS Getting Started Guide

B.2.1
CSS Guidelines for ASTRO 25 Express
The Configuration/Service Software (CSS) application enables you to use a laptop or other client
computer to configure, service, and maintain various Motorola Solutions devices in an ASTRO® 25
radio system. CSS supports devices that include the base radio and site controller equipment.

To install CSS, see the Configuration/Service Software (CSS) Getting Started Guide provided with the
software installation media. These instructions also include a procedure for configuring the CSS
computer network connection

To access the online help, select Help → CSS Help from the menu. Before performing any procedure
or process established in the online help, review the following CSS Online Help topics to ensure that
you are familiar with and have access to the appropriate topics:

CSS Main Window
To become familiar with the CSS elements and navigation components.

Overview of CSS
To become familiar with using CSS locally or through the network management subsystem.

CSS Help Links
For specific online help supporting base radio configuration and site controller configuration.

For GTR 8000 Base Radios, select Trunking Site → ASTRO 25 Express System.

For GCP 8000 Site Controller, select Site Controller Configuration and Service Help → ASTRO 25
Express System.
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B.2.1.1
Reading/Writing Configuration Files From/To a Device
When Configuration/Service Software (CSS) is installed, the online help feature provides information,
and instructional procedures to read/write a configuration file from/to a device. Perform this procedure
to read/write a configuration file from/to a device using CSS.

Procedure:
1 Access the online help. From the CSS menu, select Help → CSS Help.

2 From the list of CSS Online Help topics, expand CSS Procedures (list of procedures).

3 Select the appropriate help topic. From the CSS procedure list, select one of the following
options:

• Connecting to a Device Through an Ethernet Connection
• Connecting to a Device Through a Serial Connection
• Reading the Configuration File from a Device
• Writing the Configuration File to a Device

4 Follow the instructions provided to perform the task selected from the online help.

B.3
Software Download Manager
The Software Download Manager (SWDL) transfers and installs new firmware in RF site components
(base radios and site controllers).

NOTICE: For detailed information on uploading firmware to the base radios and site controller,
see the Software Download Manager User Guide.

The SWDL allows you to perform the following tasks:

• Download software to site devices.

• Download software to an instance of a device (such as one base station) that has been
disconnected from the radio network.

• Update the software on newly added channels or subsites.

• Determine software and hardware versions on target devices.

• Purge (delete) a software version from selected target devices.

• Obtain device IP information.

• Query the site controller for the number of channels and/or subsites in the system.

• Audit a session using historical information recorded from Software Download Manager.

To download software to an ASTRO® 25 System, you can do one of the following:

• Software download to the entire site – site controllers and base radios.

• Software download to either of the device types in the system – base radios or site controllers.

Table 27: Installing and Upgrading the Software (SDWL)

Activity Description Reference

Upgrade fac-
tory-installed
software

Launch the Software Download Manager
(SWDL) application and upgrade the factory-
installed software on the equipment to the
latest version. All base radios and all site

Software Download Manag-
er User Guide
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Activity Description Reference

controllers have consistent versions of soft-
ware.

Launches the SWDL application

B.4
Customer Programming Software
Subscriber radios are configured through Customer Programming Software (CPS). A computer running
CPS is connected to the universal connection port on the subscriber radio and the codeplug is loaded.
The configuration settings in CPS are categorized into different types, such as radio-wide settings,
controls, display, and menu settings, and secure settings. Parameters must be set according to the
services used by the radio. CPS is used to configure each radio with a system ID, the unique individual
radio ID, and as many talkgroup IDs as needed.

For subscriber radio programming details, see the subscriber radio user guide and Customer
Programming Software Online Help.

MN004282A01-A
Appendix B:  Service Laptop and Software Setup for ASTRO 25 Express

Send Feedback   113

http://docsurvey.motorolasolutions.com


This page intentionally left blank.


	Copyrights
	Contact Us
	Document History
	Contents
	List of Figures
	List of Tables
	List of Processes
	List of Procedures
	About ASTRO 25 Express Setup Guide
	What is Covered in This Manual?
	Helpful Background Information
	Related Information

	ASTRO 25 Express System Preparation
	1.1 Preparation Overview

	Equipment Setup
	2.1 ASTRO 25 Express Equipment Checklist
	2.1.1 Receive Expansion Cable Length Specifications

	2.2 GTR 8000 Expandable Site Subsystem Setup
	2.2.1 GTR 8000 Expandable Site Subsystem Power, Grounding, and Interface Connections
	2.2.1.1 GTR 8000 Expandable Site Subsystem Power Connections
	2.2.1.2 GTR 8000 Expandable Site Subsystem Grounding Connections
	2.2.1.3 Laptop Interface Connections
	2.2.1.3.1 Connecting Through a Serial Port Link
	2.2.1.3.2 Connecting Through an Ethernet Port Link

	2.2.1.4 GTR 8000 Expandable Site Subsystem Junction Panel Quick Connections
	2.2.1.5 GCP 8000 Site Controller Interface Connections


	2.3 Configuration Manager for Trunking
	2.4 GTR 8000 Base Radio Configuration Setup
	2.4.1 GTR 8000 Base Radio Configuration Using CSS
	2.4.1.1 Configuring a GTR 8000 Base Radio Using CSS
	2.4.1.2 Configuration Screens


	2.5 GCP 8000 Site Controller Configuration Setup
	2.5.1 Configuring the GCP 8000 Site Controller Using CSS
	2.5.2 GCP 8000 Site Controller Configuration Screens

	2.6 Subscriber Radios Setup
	2.6.1 XTS 5000 Portable or XTL 5000 Mobile Subscribers Configuration


	Test and Verification
	3.1 Test and Verification Requirements, Setup, and Procedures
	3.1.1 Required Test Equipment and Tools
	3.1.2 Setting up the Aeroflex/IFR Analyzers
	3.1.3 Configuring the Analyzer
	3.1.4 Testing RF Connections for the Analyzer
	3.1.5 Testing the Base Radio
	3.1.5.1 Configuring Preliminary Base Radio Settings
	3.1.5.2 Testing the Transmitter
	3.1.5.3 Testing the Receiver for FDMA Operation
	3.1.5.4 Testing the Receiver for APCO TDMA Operation

	3.1.6 Testing the RFDS
	3.1.6.1 Testing TX RFDS Output at Rated Power
	3.1.6.2 Establishing TX ERP and Setting Base Radio Power Output
	3.1.6.3 Testing RX with a Tower Top Amplifier (TTA)
	3.1.6.4 Testing RX without a Tower Top Amplifier (TTA)

	3.1.7 Setting the Final Base Radio Configuration


	Appendix A: Site Preparation and R56 Compliance Checklist
	A.1 Site Preparation
	A.2 R56 Compliance Checklist

	Appendix B: Service Laptop and Software Setup for ASTRO 25 Express
	B.1 Service Laptop Overview for ASTRO 25 Express
	B.1.1 Service Laptop Requirements for CPS for ASTRO 25 Express
	B.1.2 Service Laptop Requirements for CSS for ASTRO 25 Express
	B.1.3 Service Laptop Requirements for Other Software for ASTRO 25 Express

	B.2 Configuration/Service Software for ASTRO 25 Express
	B.2.1 CSS Guidelines for ASTRO 25 Express
	B.2.1.1 Reading/Writing Configuration Files From/To a Device


	B.3 Software Download Manager
	B.4 Customer Programming Software


